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Release Version: 2.6
Updated: Sunday, 26 January 2025 at 20:18

novelWriter is an open source plain text editor designed for writing novels assembled from individual
text documents. It uses a minimal formatting syntax inspired by Markdown, and adds a meta data syntax
for comments, synopsis, and cross-referencing. It is designed to be a simple text editor that allows for
easy organisation of text and notes, using human readable text files as storage for robustness.

The project storage is suitable for version control software, and also well suited for file synchronisation
tools. All text is saved as plain text files, and your project data as standard data formats in XML and
JSON. See How Data is Stored for more details.

Any operating system that has Python 3 and the Qt 5 libraries should be able to run novelWriter. It runs
fine on Linux, Windows and MacOS, and users have tested it on other platforms as well. See Setup and
Installation for more details.

Useful Links

• Website: https://novelwriter.io

• Documentation: https://docs.novelwriter.io

• Public Releases: https://releases.novelwriter.io

• Internationalisation: https://crowdin.com/project/novelwriter

• Source Code: https://github.com/vkbo/novelWriter

• Source Releases: https://github.com/vkbo/novelWriter/releases

• Issue Tracker: https://github.com/vkbo/novelWriter/issues

• Feature Discussions: https://github.com/vkbo/novelWriter/discussions

• PyPi Project: https://pypi.org/project/novelWriter

• Social Media: https://fosstodon.org/@novelwriter
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CHAPTER

ONE

OVERVIEW

At its core, novelWriter is a multi-document plain text editor. The idea is to let you edit your text without
having to deal with formatting until you generate a draft document or manuscript. Instead, you can focus
on the writing right from the start.

Of course, you probably need some formatting for your text. At the very least you need emphasis. Most
people are familiar with adding emphasis using _underscores_ and **asterisks**. This formatting
standard comes from Markdown and is supported by novelWriter. It also uses Markdown formatting for
defining document headings. If you need more specialised formatting, additional formatting options are
available using a shortcode format. See Formatting with Shortcodes for more details.

Limitations

novelWriter is designed for writing fiction, so the formatting features available are limited to those rel-
evant for this purpose. It is not suitable for technical writing, and it is not a full-featured Markdown
editor.

It is also not intended as a tool for organising research for writing, and therefore lacks formatting features
you may need for this purpose. The notes feature in novelWriter is mainly intended for character profiles
and plot outlines.

Your novel project in novelWriter is organised as a collection of separate plain text documents instead of
a single, large document. The idea is to make it easier to reorganise your project structure without having
to cut and paste text between chapters and scenes.

There are two kinds of documents in your project: Novel Documents are documents that are part of your
story. The other kind of documents are Project Notes, which are intended for your notes about your
characters, your world building, and so on.

You can at any point split the individual documents by their headings up into multiple documents, or
merge multiple documents into a single document. This makes it easier to use variations of the Snowflake
method for writing. You can start by writing larger structure-focused documents, like for instance one
document per act, and later effortlessly split these up into individual chapter or scene documents.

3
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1.1 Key Features

Below are some key features of novelWriter.

Focus on writing
The aim of the user interface is to let you focus on writing instead of spending time formatting text.
Formatting is therefore limited to a small set of formatting tags for simple things like text emphasis
and paragraph alignment. Additional shortcodes are available for special formatting cases when
you need them.

When you really want to focus on just writing, you can switch the editor into Focus Mode where
only the text editor panel itself is visible, and the project structure view is hidden away.

Keep an eye on your notes
The main window can optionally show a document viewer to the right of the editor. The viewer
is intended for displaying another scene document, your character notes, plot notes, or any other
document you may need to reference while writing. It is not intended as a preview panel for the
document you’re editing, but if you wish, you can also use it for this purpose.

Organise your documents how you like
You can split your novel project up into as many individual documents as you want to. When you
build the project into a manuscript, they are all glued together in the top-to-bottom order in which
they appear in the project tree. You can use as few text documents as you like, but splitting the
project up into chapters and scenes means you can easily reorder them using the drag-and-drop
feature of the project tree. You can also start out with fewer documents and then later split them
into multiple documents based on chapter and scene headings.

Multi-novel project support
The main parts of your project is split up into top level special folders called “Root” folders. Your
main story text lives in the “Novel” root folder. You can have multiple such folders in a project,
and rename them to whatever you want. This allows you to keep a series of individual novels
with the same characters and world building in the same project, and create manuscripts for them
separately.

Keep track of your story elements
All documents in your project can be assigned a tag that you can then reference from any other
document or note. In fact, you can add a new tag under each heading of a note if you need to be
able to reference specific sections of it, or you want to keep several topics or scenes in the same
document.

Get an overview of your story
It is not the documents themselves that define the chapters and scenes of your story, but the headings
within them. In the Outline View on the main window you can see an outline of all the chapter
and scene headings of each novel root folder in your project. If they have any references in them,
like which character is in what chapter and scene, these are listed in additional columns.

You can also add a synopsis to each chapter or scene, which can be listed here as well. You have
the option to add or remove columns of information from this outline. A subset of the outline
information is also available in the Novel View as an alternative view to the project tree.

Get an overview of your story elements
Under the document viewer panel you will find a series of tabs that show the different story elements
you have created tags for. The tabs are sorted into Characters, Plots, etc, depending on which
categories you are using in your story. This panel can be hidden to free up space when you don’t
need it.

4 Chapter 1. Overview
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Assembling your manuscript
Whether you want to assemble a manuscript, or export all your notes, or generate an outline of
your chapters and scenes with a synopsis included, you can use the Build Manuscript tool to do
so. The tool lets you select what information you want to include in the generated document, and
how it is formatted. You can send the result to a printer, or generate an Open Document or Word
Document file that can be opened by most office type word processors. You can also generate the
result as HTML, or Markdown, both suitable for further conversion to other formats.

1.2 Screenshots

Fig. 1: novelWriter with light colour theme

1.2. Screenshots 5
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Fig. 2: novelWriter with dark colour theme
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CHAPTER

TWO

WHAT TO READ FIRST

The documentation of novelWriter is quite extensive. There are a lot of features to get used to, but you
don’t need to know all of them to get started.

The chapters below labelled “Essential Information” are the ones you need to know to use the application
correctly. By “correctly” it is meant: in a way so novelWriter understands the basic structure of your text.
It collects a lot of information from your text and uses it to display the structure of it in various ways to
help you get an overview of your writing.

The chapters labelled “Recommended Reading” includes additional information on how the different
parts if the application work and what the features do.

The “Optional” and “Lookup” chapters contain additional information or lookup tables that are not es-
sential for using the application.

2.1 Using novelWriter

In order to use novelWriter effectively, you need to know the basics of how it works. The following
chapters will explain the main principles. They start with the basics, and get more detailed as you read
on.

How it Works – Essential Information
This chapter explains the basics of how the application works and what it can and cannot do.

Project Views – Recommended Reading
This chapter will give you a more detailed explanation of how you can use the user interface com-
ponents to organise and view your project work.

The Editor and Viewer – Recommended Reading
This chapter will give you a more detailed explanation of how the text editor and viewer work.

Formatting Your Text – Essential Information
This chapter covers how you should format your text. The editor is plain text, so text formatting re-
quires some basic markup. The structure of your novel is also inferred from how you use headings.
Tags and references are implemented by special keywords.

Keyboard Shortcuts – Optional / Lookup
This chapter lists all the keyboard shortcuts in novelWriter and what they do. Most of the shortcuts
are also listed next to their menu entries inside the app, or in tool tips. This chapter is mostly for
reference.

Typographical Notes – Optional
This chapter gives you an overview of the special typographical symbols available in novelWriter.

7
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The auto-replace feature can handle the insertion of standard quote symbols for your language, and
other special characters. If you use any symbols aside from these, their intended use is explained
here.

2.2 Organising Your Projects

In addition to managing a collection of plain text files, novelWriter can interpret and map the structure
of your novel and show you additional information about its flow and content. In order to take advantage
of these features, you must structure your text in a specific way and add some meta data for it to extract.

Managing Projects – Essential Information
This chapter explains how you organise the content of your project, and how to set up automated
backups of your work.

Novel Structure – Essential Information
This chapter covers the way your novel’s structure is encoded into the text documents. It explains
how the different levels of headings are used, and some special formatting for different kinds of
headings.

Tags and References - Recommended Reading
This chapter explains how you organise your notes, and how the Tags and References system works.
This system lets you cross-link your documents in your project, and display these references in the
application interface.

Building the Manuscript - Recommended Reading
This chapter explains how the Manuscript Build tool works, how you can control the way chapter
titles are formatted, and how scene and section breaks are handled.

2.3 Additional Details & Technical Topics

The Additional Details and the Technical Topics sections contain more in-depth information about how
various bits of novelWriter works. This information is not essential to getting started using novelWriter.

8 Chapter 2. What to Read First



CHAPTER

THREE

SETUP AND INSTALLATION

Ready-made packages and installers for novelWriter are available for all major platforms, including
Linux, Windows and MacOS, from the Downloads page. See below for additional install instructions
for each platform.

You can also install novelWriter from the Python Package Index (PyPi). See Installing from PyPi. In-
stalling from PyPi does not set up icon launchers, so you will either have to do this yourself, or start
novelWriter from the command line.

Spell checking in novelWriter is provided by a third party library called Enchant. Generally, it should
pull dictionaries from your operating system automatically. However, on Windows they must be installed
manually. See Spell Check Dictionaries for more details.

3.1 Installing on Windows

You can install novelWriter with both Python and library dependencies embedded using the Windows
Installer (setup.exe) file from the Downloads page, or from the Releases page on GitHub. Installing it
should be straightforward.

If you have any issues, try uninstalling the previous version and making a fresh install. If you already had
a version installed via a different method, you should uninstall that first as having multiple installations
has been known to cause problems.

3.2 Installing on Linux

A Debian package can be downloaded from the Downloads page, or from the Releases page on GitHub.
This package should work on both Debian, Ubuntu and Linux Mint, at least.

If you prefer, you can also add the novelWriter repository on Launchpad to your package manager. The
Launchpad packages are signed by the author.

9
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3.2.1 Ubuntu

You can add the Ubuntu PPA and install novelWriter with the following commands.

sudo add-apt-repository ppa:vkbo/novelwriter
sudo apt update
sudo apt install novelwriter

If you want the Pre-Release PPA instead, add the ppa:vkbo/novelwriter-pre repository.

3.2.2 Debian and Mint

Since this is a pure Python package, the Launchpad PPA can in principle also be used on Debian or Mint.
However, the above command will fail to add the signing key, as it is Ubuntu-specific.

Instead, run the following commands to add the repository and key:

sudo gpg --no-default-keyring --keyring /usr/share/keyrings/novelwriter-ppa-
→˓keyring.gpg --keyserver hkp://keyserver.ubuntu.com:80 --recv-keys␣
→˓F19F1FCE50043114
echo "deb [signed-by=/usr/share/keyrings/novelwriter-ppa-keyring.gpg] http://
→˓ppa.launchpad.net/vkbo/novelwriter/ubuntu noble main" | sudo tee /etc/apt/
→˓sources.list.d/novelwriter.list

Then run the update and install commands as for Ubuntu:

sudo apt update
sudo apt install novelwriter

Tip: If you get an error message like gpg: failed to create temporary file when importing
the key from the Ubuntu keyserver, try creating the folder it fails on, and import the key again:

sudo mkdir /root/.gnupg/

3.2.3 AppImage Releases

For other Linux distros than the ones mentioned above, the primary option is AppImage. These are
completely standalone images for the app that include the necessary environment to run novelWriter.
They can of course be run on any Linux distro, if you prefer this to native packages.

Note: novelWriter generally doesn’t support Python versions that have reached end of life. If your Linux
distro still uses older Python versions and novelWriter won’t run, you may want to try the AppImage
instead.

10 Chapter 3. Setup and Installation
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3.3 Installing on MacOS

You can install novelWriter with both its Python and library dependencies embedded using the DMG
application image file from the Downloads page, or from the Releases page on GitHub. Installing it
should be straightforward.

• Download the DMG file and open it. Then drag the novelWriter icon to the Applications folder on
the right. This will install it into your Applications.

• The first time you try to launch it, it will say that the bundle cannot be verified, simply press the
Open button to add an exception.

• If you are not presented with an Open button in the dialog, launch the application again by right
clicking on the application in Finder and selecting Open from the context menu.

The context menu can also be accessed by option-clicking if you have a one button mouse. This is done
by holding down the option key on your keyboard and clicking on the application in Finder.

Note: The novelWriter DMG is not signed because Apple doesn’t currently provide a way for non-profit
open source projects to properly sign their installers. The novelWriter project doesn’t have the funding
to pay for a commercial software signing certificate.

3.4 Installing from PyPi

novelWriter is also available on the Python Package Index, or PyPi. This install method works on all
supported operating systems with a suitable Python environment.

To install from PyPi you must first have the python and pip commands available on your system. You
can download Python from python.org. It is recommended that you install the latest version. If you are
on Windows, also make sure to select the “Add Python to PATH” option during installation.

To install novelWriter from PyPi, use the following command:

pip install novelwriter

To upgrade an existing installation, use:

pip install --upgrade novelwriter

When installing via pip, novelWriter can be launched from command line with:

novelwriter

Make sure the install location for pip is in your PATH variable. This is not always the case by default,
and then you may get a “Not Found” error when running the novelwriter command.
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CHAPTER

FOUR

TIPS & TRICKS

This is a list of hopefully helpful little tips on how to get the most out of novelWriter.

Note: This section will be expanded over time. If you would like to have something added, feel free to
contribute, or start a discussion on the project’s Discussions Page.

4.1 Managing the Project

How do I create a project from a template?

On the Welcome dialog’s Create New Project form, you can select to “Prefill Project” from the content
of a different project. This feature is most useful if you copy a project you have dedicated to be a template
project. If you have a structure and settings you want to use for every new project, this is the best solution.

How do I merge multiple documents into one?

If you need to merge a selection of documents in your project into a single document, you can achieve
this by first making a new folder for just that purpose, and drag all the documents you want merged into
this folder. Then you can right click the folder, select Transform and Merge Documents in Folder.

In the dialog that pops up, the documents will be in the same order as in the folder, but you can rearrange
them here of you wish. See Splitting and Merging Documents for more details.

How do I share status or importance labels between projects?

The status or importance labels you have defined in a project can be exported from Project Settings from
the respective configuration tabs. You can then import these labels in another project.

13
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4.2 Layout Tricks

How do I create a table?

The formatting tools available in novelWriter don’t allow for complex structures like tables. However,
the editor does render tabs in a similar way that regular word processors do. You can set the width of a
tab in Preferences.

The tab key should have the same distance in the editor as in the viewer, so you can align text in columns
using the tab key, and it should look the same when viewed next to the editor.

This is most suitable for your notes, as the result in exported documents cannot be guaranteed to match.
Especially if you don’t use the same font in your manuscript as in the editor.

How do I force a line break when line breaks are ignored in my manuscript?

In the Manuscript Build Settings you can choose to ignore line breaks within paragraphs in your text.
However, some times you still need those breaks. Like for instance on the cover page where you may
need to add your name and address. In such cases, you can add [br] where you want line breaks. These
breaks cannot be ignored by any settings and will always be respected.

New in version 2.6.

How do I turn off first line indent for a specific paragraph?

If you have first line indent enabled, but have a specific paragraph that you don’t want indented, you
can disable the indentation by explicitly adding text alignment. For instance by adding << to the end to
left-align it. Aligned paragraphs are not indented.

See Paragraph Alignment and Indentation for more details.

4.3 Organising Your Text

How do I add introductory text to chapters?

Sometimes chapters have a short preface, like a brief piece of text or a quote to set the stage before the
first scene begins.

If you add separate files for chapters and scenes, the chapter file is the perfect place to add such text.
Separating chapter and scene files also allows you to make scene files child documents of the chapter.
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How do I distinguishing between soft and hard scene breaks?

Depending on your writing style, you may need to separate between soft and hard scene breaks within
chapters. Like for instance if you switch point-of-view character often.

In such cases you may want to use different scene headings for hard and soft scene breaks. The Build
Manuscript tool will let you define a different format for scenes using the ### and ###! heading codes
when you generate your manuscript. You can for instance add the common “* * *” for hard breaks
and select to hide soft scene breaks, which will just insert an empty paragraph in their place. See Build
Settings for more details.

New in version 2.4.

4.4 Other Tools

How do I convert my project to/from the yWriter format?

There is a tool available that lets you convert a yWriter project to a novelWriter project, and vice versa.

The tool is available at peter88213.github.io/yw2nw

4.4. Other Tools 15
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CHAPTER

FIVE

GLOSSARY

Context Menu
A context menu is a menu that pops up when you right click something in the user interface. In
novelWriter, you can often also open a context menu by pressing the keyboard shortcut Ctrl+..

Headings
Each level of headings in Novel Documents have a specific meaning in terms of the structure of the
story. That is, they determine what novelWriter considers a partition, a chapter, a scene or a text
section. For Project Notes, the heading levels don’t matter. For more details on headings in novel
documents, see Importance of Headings.

Keyword
A keyword in novelWriter is a special command you put in the text of your documents. They are
not standard Markdown, but are used in novelWriter to add information that is interpreted by the
application. For instance, keywords are used for tags and references.

Keywords must always be on their own line, and the first character of the line must always be the
@ character. The keyword must also always be followed by a : character, and the values passed to
the command are added after this, separated by commas.

Novel Documents
These are documents that are created under a “Novel” Root Folder. They behave differently than
Project Notes, and have some more restrictions. For instance, they can not exist in folders intended
only for project notes. See the Novel Structure chapter for more details.

Project Index
The project index is a record of all headings in a project, with all their meta data like synopsis
comments, tags and references. The project index is kept up to date automatically, but can also be
regenerated manually from the Tools menu or by pressing F9.

Project Notes
Project Notes are unrestricted documents that can be placed anywhere in your project. You should
not use these documents for story elements, only for notes. Project notes are the source files used
by the Tags and References system. See the Tags and References chapter for more details on how
to use them.

Reference
A reference is one of a set of keywords that can be used to link to a tag in another document. The
reference keywords are specific to the different root folder types. A full overview is available in
the Tags and References chapter.

Root Folder
A “Root Folder” is a top level folder of the project tree in novelWriter. Each type of root folder has
a specific icon to identify it. For an overview of available root folder types, see Project Structure.
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Tag
A tag is a user defined value assigned as a tag to a section of your Project Notes. It is optional,
and can be defined once per heading. It is set using the keyword syntax @tag: value, where
value is the user defined part. Each tag can be referenced in another file using one of the reference
keywords. See Tags and References chapter for more details.
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CHAPTER

SIX

HOW IT WORKS

The main features of novelWriter are listed in the Overview chapter. In this chapter, we go into some more
details on how they are implemented. This is intended as an overview. Later on in this documentation
these features will be covered in more detail.

6.1 GUI Layout and Design

The user interface of novelWriter is intended to be as minimalistic as practically possible, while at the
same time provide useful features needed for writing a novel.

The main window does not by default have an editor toolbar like many other applications do. This reduces
clutter, and since the documents are formatted with style tags, it is not needed most of the time. Still, a
small formatting toolbar can be popped out by clicking the left-most button in the header of the document
editor. It gives quick access to standard formatting codes.

Most formatting features supported are available through convenient keyboard shortcuts. They are also
available in the main menu under Format, so you don’t have to look up formatting codes every time you
need them. For reference, a list of all shortcuts can be found in the Keyboard Shortcuts chapter.

Note: novelWriter is not intended to be a full office type word processor. It doesn’t support images,
links, tables, and other complex structures and objects often needed for such documents. Formatting is
limited to headings, in-line basic text formats, text alignment, and a few other simple features.

On the left side of the main window, you will find a sidebar. This bar has buttons for the standard views
you can switch between, a quick link to the Build Manuscript tool, and a set of project-related tools and
quick access to settings at the bottom.

New in version 2.2: A number of new formatting options were added in 2.2 to allow for some special
formatting cases. At the same time, a small formatting toolbar was added to the editor. It is hidden by
default, but can be opened by pressing the button in the top–left corner of the editor header.
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6.1.1 Project Tree and Editor View

Fig. 1: A screenshot of the Project Tree and Editor View.

When the application is in Project Tree View mode, the work area of the main window is split in two,
or optionally three, panels. The left-most panel contains the project tree and all the documents in your
project. The second panel is the document editor.

An optional third panel on the right side contains a document viewer which can view any document in
your project independently of what is open in the document editor. This panel is not intended as a preview
window, although you can use it for this purpose if you wish. For instance if you need to check that the
formatting tags behave as you expect. However, the main purpose of the viewer is for viewing your notes
next to your editor while you’re writing.

The editor also has a Focus Mode you can toggle either from the menu, from the icon in the editor’s
header, or by pressing F8. When Focus Mode is enabled, all the user interface elements other than the
document editor itself are hidden away.

The project tree will highlight with a different background colour the document that is currently open in
the editor.

New in version 2.6: You can now drag and drop documents from the project tree onto the editor or viewer
panels to open them.
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6.1.2 Novel View and Editor View

Fig. 2: A screenshot of the Novel Tree and Editor View.

When the application is in Novel Tree View mode, the project tree is replaced by an overview of your
novel structure for a specific Novel root folder. Instead of showing individual documents, the tree now
shows all headings of your novel text. This includes multiple headings within the same document.

Each heading is indented according to the heading level, not its parent/child relationship to other elements
of your project. You can open and edit your novel documents from this view as well. All headings
contained in the currently open document should be highlighted in the view to indicate which ones belong
together in the same document.

If you have multiple Novel type root folders, the header of the novel view becomes a dropdown box. You
can then switch between them by clicking the Outline of . . . text. You can also click the novel icon button
next to it.

Generally, the novel view should update when you make changes to the novel structure, including edits
of the current document in the editor. The information is only updated when the automatic save of the
document is triggered, or you manually press Ctrl+S to save changes. (You can adjust the auto-save
interval in Preferences.) You can also regenerate the whole novel view by pressing the refresh button in
the novel view header.

It is possible to show an optional third column in the novel view. The settings are available from the
menu button in the toolbar.

If you click the triangular icon to the right of each item, a tooltip will pop out showing all the meta data
collected for that heading.
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User Guide, Release 2.6

6.1.3 Novel Outline View

Fig. 3: A screenshot of the Novel Outline View.

When the application is in Novel Outline View mode, the tree, editor and viewer are replaced by a large
table that shows the entire novel structure with all the tags and references listed. Pretty much all collected
meta data is available here in different columns.

You can select which novel root folder to display from the dropdown box, and you can select which
columns to show or hide from the menu button. You can also rearrange the columns by drag and drop.
The app remembers your column order and sizes between sessions, and for each individual project.

6.1.4 Colour Themes

By default, novelWriter uses a light colour theme. You can also choose between a standard dark theme
that have neutral colours, or a series of other included themes, from Preferences.

If you wish, you can create your own colour themes, and even have them added to the application. See
Syntax and GUI Themes for more details.

Switching the GUI colour theme does not affect the colours of the editor and viewer. They have separate
colour selectable from the “Document colour theme” setting in Preferences. They are separated because
there are a lot more options to choose from for the editor and viewer.

Note: If you switch between light and dark mode on the GUI, you should also switch editor theme to
match, otherwise icons may be hard to see in the editor and viewer.
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6.1.5 Project Search

A global search tool is available from the side bar. It allows you to search through your entire project.
The tool does not provide a replace feature. There is a search and replace tool available in the document
editor that acts on the open document.

New in version 2.4.

6.1.6 Switching Focus

If the project or novel view does not have focus, pressing Ctrl+T switches focus to whichever of the two
is visible. If one of them already has focus, the key press will switch between them instead.

Likewise, pressing Ctrl+E will switch focus to the document editor or viewer, or if any of them already
have focus, it will switch focus between them,

These two shortcuts make it possible to jump between all these GUI elements without having to reach
for the mouse or touchpad.

6.2 Project Layout

This is a brief introduction to how you should structure your writing projects. All of this will be covered
in more detail later.

The main point of novelWriter is that you are free to organise your project documents as you wish into
sub-folders or sub-documents, and split the text between these documents in whatever way suits you. All
that matters to novelWriter is the linear order the documents appear at in the project tree (top to bottom).
The chapters, scenes and sections of the novel are determined by the headings within those documents.

Fig. 4: An illustration of how heading levels correspond to the novel structure.

The four heading levels, Level 1 to Level 4, are treated as follows:

• Level 1 is used for the novel title, and for partitions.

• Level 2 is used for chapter tiles.

• Level 3 is used for scene titles – optionally replaced by separators.
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• Level 4 is for section titles within scenes, if such granularity is needed.

The project tree will select an icon for the document based on the first heading in it.

This heading level structure is only taken into account for novel documents. For project notes, the heading
levels have no structural meaning, and you are free to use them however you want. See Novel Structure
and Tags and References for more details.

Tip: You can add documents as child items of other documents. This is often more useful than adding
folders, since you anyway may want to have the chapter heading in a separate document from your in-
dividual scene documents so that you can rearrange scene documents freely without affecting chapter
placement.

New in version 2.6: The heading levels for partitions, chapters and scenes only apply within novelWriter.
When you generate your manuscript, chapters are considered as the topmost heading level, with scenes
below it. Partitions are inserted as text elements in most formats.

6.3 Building a Manuscript

The project can at any time be assembled into a range of different formats through the Build Manuscript
tool. Natively, novelWriter supports Open Document, Microsoft Word Document (known as Office Open
XML), HTML5, and various flavours of Markdown. You can also generate a PDF document.

The HTML5 format is suitable for conversion by a number of other tools like Pandoc, or for importing into
word processors if the Open Document or Word Document format isn’t suitable. The Open Document
format is supported by most office type applications, so is the Word Document format. In addition,
printing is also possible.

For advanced processing, you can export the content of the project to a JSON file. This is useful if you
want to write your own custom processing script in for instance Python, as the entire novel can be read
into a Python dictionary with a couple of lines of code. The JSON file can be populated with either
HTML formatted text, or with the raw text as typed it into the novel documents.

See Building the Manuscript for more details.

New in version 2.1: You can now define multiple build definitions in the Build Manuscript tool. This
allows you to define specific settings for various types of draft documents, outline documents, and
manuscript formats. See Building the Manuscript for more details.

6.4 Project Storage

The files of a novelWriter project are stored in a dedicated project folder. The project structure is kept in
a file at the root of this folder called nwProject.nwx. All the document files and associated meta data
are stored in other folders below the project folder. For a more technical description of what all the files
mean and how they’re organised, see the How Data is Stored section.

This way of storing data was chosen for several reasons.

Firstly, all the text you add to your project is saved directly to your project folder in separate files. Only
the project structure and the text you are currently editing is stored in memory at any given time, which
means there is a smaller risk of losing data if the application or your computer crashes.
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Secondly, having multiple small files means it is very easy to synchronise them between computers with
standard file synchronisation tools.

Thirdly, if you use version control software to track the changes to your project, the file formats used for
the files are well suited. All the JSON documents have line breaks and indents as well, which makes it
easier to track them with version control software.

Note: Since novelWriter has to keep track of a bunch of files and folders when a project is open, it may
not run well on some virtual file systems. A file or folder must be accessible with exactly the path it was
saved or created with. An example where this is not the case is the way Google Drive is mapped on Linux
Gnome desktops using gvfs/gio.

Caution: You should not add additional files to the project folder yourself. Nor should you, as a rule,
manually edit files within it. If you really must manually edit the text files, e.g. with some automated
task you want to perform, you need to rebuild the Project Index when you open the project again.

Editing text files in the content folder is less risky as these are just plain text. Editing the main
project XML file, however, may make the project file unreadable and you may crash novelWriter and
lose project structure information and project settings.
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CHAPTER

SEVEN

PROJECT VIEWS

This chapter covers in more detail the different project views available in novelWriter.

Fig. 1: The Project Content tree as it appears when loading a sample project.
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7.1 The Project Tree

The main window contains a project tree in the left-most panel. It shows the entire structure of the project,
and has four columns.

Column 1
The first column shows the icon and label of each folder, document, or note in your project. The
label is not the same as the heading title you set inside the document. However, the document’s
label will appear in the header above the document text itself so you know where in the project an
open document belongs. The icon is selected based on the type of item, and for novel documents,
the level of the first heading in the document text.

Column 2
The second column shows the word count of the document, or the sum of words of the child items
for folders and documents with sub-documents. If the counts seem incorrect, they can be updated
by rebuilding the project index from the Tools menu, or by pressing F9.

Column 3
The third column indicates whether the document is considered active or inactive in the project.
You can use this flag to indicate that a document is still in the project, but should not be consid-
ered an active part of it. When you run the Build Manuscript tool, you can include or exclude
documents based on this flag. You can change this value from the right-click context menu.

Column 4
The fourth column shows the user-defined status or importance labels you’ve assigned to each
project item. See Document Importance and Status for more details on how to uses these labels.
You can select these labels from the context menu, and define them in Project Settings.

Right-clicking an item in the project tree will open a context menu under the cursor, displaying a selection
of actions that can be performed on the selected item.

At the top of the project tree, you will find a set of buttons.

• The first button is a quick links button that will show you a dropdown menu of all the root folders
in your project. Selecting one will move to that position in the tree. You can also activate this
menu by pressing Ctrl+L.

• The next two buttons can be used to move items up and down in the project tree. This is the only
way to move root folders.

• The next button opens a dropdown menu for adding new items to the tree. This includes root
folders and template documents. You can also activate this dropdown menu by pressing Ctrl+N.

• The last button is a menu of further actions you can apply to the project tree.

Below the project tree you will find a small details panel showing the full information of the currently
selected item. This panel also includes the latest paragraph and character counts in addition to the word
count.

Tip: If you want to set the label of a document to be the same as a header within it, you can right-click a
header in the document when it is open in the editor and select Set as Document Name from the context
menu.
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7.1.1 Splitting and Merging Documents

Under the Transform submenu in the context menu of an item in the project tree, you will find several
options on how to change a document or folder. This includes changing between document and note, but
also splitting them into multiple documents, or merging child items into a single document.

Splitting Documents

Fig. 2: The Split Document dialog.

The Split Document by Headings option will open a dialog that allows you to split the selected document
into multiple new documents based on the headings it contains. You can select at which heading level
the split is to be performed from the dropdown box. The list box will preview which headings will be
split into new documents.

You are given the option to create a folder for these new documents, and whether or not to create a
hierarchy of documents. That is, put sections under scenes, and scenes under chapters.

The source document is not deleted in the process, but you have the option to let the tool move the source
document to the Trash folder.
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Merging Documents

Fig. 3: The Merge Documents dialog.

You have two options for merging documents that are child elements of another document. You can
either Merge Child Items into Self and Merge Child Items into New. The first option will pull all
content of child items and merge them into the parent document, while the second option will create a
new document in the process.

When merging documents in a folder, you only have the latter process is possible, so only the choice
Merge Documents in Folder is available.

In either case, the Merge Documents dialog will let you exclude documents you don’t want to include,
and it also lets you reorder them if you wish.

7.1.2 Document Importance and Status

Each document or folder in your project can have either a “Status” or “Importance” flag set. These are
flags that you control and define yourself, and novelWriter doesn’t use them for anything. To modify the
labels, go to their respective tabs in Project Settings.

The “Status” flag is intended to tag a novel document as for instance a draft or as completed, and the
“Importance” flag is intended to tag character notes, or other project notes, as for instance a main, major,
or minor character or story element.

Whether a document uses a “Status” or “Importance” flag depends on which root folder it lives in. If it’s
in a Novel type folder, it uses the “Status” flag, otherwise it uses an “Importance” flag.
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7.1.3 Project Tree Drag & Drop

The project tree allows drag & drop to allow you to reorder your documents and folders. Moving a
document in the project tree will affect the text’s position when you assemble your manuscript in the
Manuscript Build tool.

New in version 2.2: You can now select multiple items in the project tree by holding down the Ctrl or
Shift key while selecting items.

Documents and their folders can be rearranged freely within their root folders. If you move a Novel
Document out of a Novel folder, it will be converted to a Project Note. Notes can be moved freely
between all root folders, but keep in mind that if you move a note into a Novel type root folder, its
“Importance” setting will be replaced by a “Status” setting. See Document Importance and Status. The
old value will not be overwritten though, and should be restored if you move it back at some point.

Root folders in the project tree cannot be dragged and dropped at all. If you want to reorder them, you
can move them up or down with respect to each other from the arrow buttons at the top of the project
tree, or by pressing Ctrl+Up or Ctrl+Down when they are selected.

Tip: You can drag and drop documents onto the editor or viewer panel to open them.

7.2 The Novel Tree View

Fig. 4: A screenshot of the Novel Tree View.

An alternative way to view the project structure is the novel view. You can switch to this view by selecting
the Novel View button in the sidebar. This view is a simplified version of the view in the Outline View.
It is convenient when you want to browse the structure of the story itself rather than the document files.
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Note: You cannot reorganise the entries in the novel view, or add any new documents, as that would
imply restructuring the content of the document files themselves. Any such editing must be done in the
project tree. However, you can add new headings to existing documents, or change references, which will
be updated in this view when the document is saved.

7.3 The Novel Outline View

Fig. 5: A screenshot of the Novel Outline View.

The project’s Novel Outline View is available as another view option from the sidebar. The outline
provides an overview of the novel structure, displaying a tree hierarchy of the elements of the novel, that
is, the level 1 to 4 headings representing partitions, chapters, scenes and sections.

The document containing the heading can also be displayed as a separate column, as well as the line
number where the heading is defined. Double-clicking an entry will open the corresponding document
in the editor and switch to Project Tree View mode.

You can select which novel folder to display from the dropdown menu. You can optionally also choose
to show a combination of all novel folders.

Note: Since the internal structure of the novel does not depend directly on the folder and document
structure of the project tree, this view will not necessarily look the same, depending on how you choose
to organise your documents. See the Novel Structure page for more details.

Various meta data and information extracted from tags can be displayed in columns in the outline. A
default set of such columns is visible, but you can turn on or off more columns from the menu button in
the toolbar. The order of the columns can also be rearranged by dragging them to a different position.
You column settings are saved between sessions on a per-project basis.
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Note: The Title column cannot be disabled or moved.

The information viewed in the outline is based on the project index. While novelWriter does its best to
keep the index up to date when contents change, you can always rebuild it manually by pressing F9 if
something isn’t right.

The outline view itself can be regenerated by pressing the refresh button. By default, the content is
refreshed each time you switch to this view.

The Synopsis column of the outline view takes its information from a specially formatted comment. See
Comments and Synopsis.
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CHAPTER

EIGHT

THE EDITOR AND VIEWER

This chapter covers in more detail how the document editor and viewer panels work.

8.1 Editing a Document

Fig. 1: A screenshot of the Document Editor panel.

To edit a document, double-click it in the project tree, press the Return key while having it selected, or
drag and drop it onto the editor panel. This will open the document in the document editor. The editor
uses a Markdown-like syntax for some features, and a novelWriter-specific syntax for others. The syntax
format is described in the Formatting Your Text chapter.
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The editor has a maximise button, which toggles the Focus Mode, and a close button in the top–right
corner. On the top–left side you will find a tools button that opens a toolbar with a few buttons for
applying text formatting, a drop down menu for navigating between headings, and a search button to
open the search dialog.

Both the document editor and viewer will show the label of the currently open document in the header
at the top of the edit or view panel. Optionally, the full project path to the document can be shown. This
can be set in Preferences.

Tip: Clicking on the document title bar will select the document in the project tree and thus reveal its
location there, making it easier to find in a large project.

Any references in the editor can be opened in the viewer by moving the cursor to the label and pressing
Ctrl+Return. You can also control-click them with your mouse.

8.1.1 Spell Checking

A third party library called Enchant is used for spell checking in the editor. The controls for spell checking
can be found in the Tools menu. You can also set spell checking language in Project Settings.

This spell checking library comes with support for custom words that you can add by selecting “Add Word
to Dictionary” from the context menu when a word is highlighted by the spell checker as misspelled. The
custom words are managed on a per-project basis, and can the list of words can be edited from the Project
Word List tool available from the Tools menu.

Note: Generally, spell checking dictionaries are collected from your operating system, but on Windows
they are not. See Spell Check Dictionaries for how to add spell checking dictionaries on Windows.

8.1.2 Editor Auto-Completer

If you type the character @ on a new line, a pop-up menu will appear showing the different available
keywords. The list will shorten as you type. Once a keyword command has been selected or typed, the
editor may suggest further options based on your project content. See The References Auto-Completer
for more details.

New in version 2.2.

8.2 Viewing a Document

Any document in the project tree can also be viewed in parallel in a right hand side document viewer.
To view a document, press Ctrl+R, select View Document in the menu or context menu, or drag and
drop the document onto the viewer panel. If you have a middle mouse button, middle-clicking on the
document will also open it in the viewer.

The document viewed does not have to be the same document as the one currently being edited. However,
If you are viewing the same document, pressing Ctrl+R from the editor will update the document with
your latest changes. You can also press the reload button in the top–right corner of the viewer panel, next
to the close button, to achieve the same thing.
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Fig. 2: A screenshot of the Document Viewer panel.

In the viewer references become clickable links. Clicking them will replace the content of the viewer
with the content of the document the reference points to.

The document viewer keeps a history of viewed documents, which you can navigate with the arrow
buttons in the top–left corner of the viewer. If your mouse has backward and forward navigation buttons,
these can be used as well. They work just like the backward and forward features in a browser. The
left-most button is a dropdown menu for quickly navigation between headings in the document. The edit
button on the right will open the viewed document in the editor.

At the bottom of the view panel there is a References panel. (If it is hidden, click the button on the left
side of the footer area to reveal it.) This panel contains a References tab with links to all documents
referring back to the one you’re currently viewing, if any has been defined. If you have created root
folders and tags for various story elements like characters and plot points, these will appear as additional
tabs in this panel.

Note: The References panel relies on an up-to-date index of the project. The index is maintained
automatically. However, if anything is missing, or seems wrong, the index can always be rebuilt by
selecting Rebuild Index from the Tools menu, or by pressing F9.

New in version 2.2: The reference panel was redesigned and the additional tabs added.
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8.3 Search & Replace

Fig. 3: A screenshot of the Document Editor search box.

The document editor has a search and replace tool that can be activated with Ctrl+F for search mode or
Ctrl+H for search and replace mode.

Pressing Return while in the search box will search for the next occurrence of the word, and
Shift+Return for the previous. Pressing Return in the replace box, will replace the highlighted text
and move to the next result.

There are a number of settings for the search tool available as toggle switches above the search box.
They allow you to search for, in order: matched case only, whole word results only, search using regular
expressions, loop search when reaching the end of the document, and move to the next document when
reaching the end. There is also a switch that will try to match the case of the word when the replacement
is made. That is, it will try to keep the word upper, lower, or capitalised to match the word being replaced.

See also:

For more information on the capabilities of the Regular Expression option, see the Qt documentation for
the QRegularExpression class.

8.4 Auto-Replace as You Type

A few auto-replace features are supported by the editor. You can control every aspect of the auto-replace
feature from Preferences. You can also disable this feature entirely if you wish.

Tip: If you don’t like auto-replacement, all symbols inserted by this feature are also available in the
Insert menu, and via Insert Shortcuts. You may also be using a Compose Key setup, which means you
may not need the auto-replace feature at all.

The editor is able to replace two and three hyphens with short and long dashes, triple points with el-
lipsis, and replace straight single and double quotes with user-defined quote symbols. It will also try
to determine whether to use the opening or closing symbol, although this feature isn’t always accurate.
Especially distinguishing between closing single quote and apostrophe can be tricky for languages that
use the same symbol for these, like English does.

Tip: If the auto-replace feature changes a symbol when you did not want it to change, pressing Ctrl+Z
once after the auto-replacement will undo it without undoing the character you typed before it.
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8.5 Dialogue Highlighting

The editor and viewer can optionally highlight character dialogue in your novel documents. By default,
this feature is set to display text in double quotes as dialogue. In Preferences, you can change this to
support various other dialogue markers that instead uses dashes to indicate dialogue, like those used in
Spanish, Portuguese, Polish, etc.

Various styles are supported by changing the settings under “Text Highlighting” in Preferences.

It is also possible to include the dialogue highlighting in your manuscripts.
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CHAPTER

NINE

FORMATTING YOUR TEXT

The novelWriter text editor is a plain text editor that uses formatting codes for setting meta data values and
allowing for some text formatting. The syntax is based on Markdown, but novelWriter is not a Markdown
editor. It supports basic formatting like emphasis (italic), strong importance (bold) and strike through
text, as well as four levels of headings. For some further complex formatting needs, a set of shortcodes
can be used.

In addition to formatting codes, novelWriter allows for comments, a synopsis tag, and a number of key-
word and value sets used for tags and references. There are also some codes that apply to whole para-
graphs. See Text Paragraphs for more details.

URLs should also be highlighted and become clickable. However, only URLs starting with “http” or
“https” are recognised. In the editor, you must hold down the Ctrl key when clicking a URL to follow
it.

9.1 Syntax Highlighting

The editor has a syntax highlighter feature that is meant to help you know when you’ve used the formatting
tags or other features correctly. It will change the colour and font size of your headings, change the text
colour of emphasised text, and it can also show you where you have dialogue in your text.

Fig. 1: An example of the colour highlighting of references. “Bob” is not defined, and “@blabla” is not
a valid reference type.

When you use the keywords to set tags and references, these also change colour. Correct keywords have
a distinct colour, and the references themselves will get a colour if they are valid. Invalid references will
get a squiggly error line underneath. The same applies to duplicate tags.
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There are a number of syntax highlighter colour themes available, both for light and dark GUIs. You can
select them from Preferences.

9.2 Headings

Fig. 2: An illustration of how heading levels correspond to the novel structure.

Four levels of headings are allowed. For project notes, they are free to be used as you see fit. That is,
novelWriter doesn’t assign the different headings any particular meaning. However, for novel documents
they indicate the structural level of the novel and must be used correctly to produce the intended result.
See Importance of Headings for more details.

# Title Text
Heading level one. For novel documents, the level indicates the start of a new partition. Partitions
are for when you want to split your story into “Part 1”, “Part 2”, etc. You can also choose to use
them for splitting the text up into acts, and then hide these headings in your manuscript.

## Title Text
Heading level two. For novel documents, the level indicates the start of a new chapter. Chapter
numbers can be inserted automatically when building the manuscript.

### Title Text
Heading level three. For novel documents, the level indicates the start of a new scene. Scene
numbers or scene separators can be inserted automatically when building the manuscript, so you
can use the title field as a working title for your scenes if you wish, but you must provide a minimal
title.

#### Title Text
Heading level four. For novel documents, the level indicates the start of a new section. Section
titles can be replaced by separators or ignored completely when building the manuscript.

For headings level one through three, adding a ! modifies the meaning of the heading:

#! Title Text
This tells the build tool that the level one heading is intended to be used for the novel or notes
folder’s main title, like for instance the novel title on the cover page. When building the manuscript,
this will use a different styling.
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##! Title Text
This tells the build tool to not assign a chapter number to this chapter title if automatic chapter
numbers are being used. Such titles are useful for prologues and epilogues for instance. See
Unnumbered Chapter Headings for more details.

###! Title Text
This is an alternative scene heading that can be formatted differently in the Manuscript Build tool.
It is intended for separating “soft” and “hard” scene breaks. Aside from this, it behaves identically
to a regular scene heading. See Hard and Soft Scene Breaks for more details.

Note: The space after the # or ! character is mandatory. The syntax highlighter will change colour and
font size when the heading is correctly formatted.

9.3 Text Paragraphs

A text paragraph is indicated by a blank line. That is, you need two line breaks to separate two fragments
of text into two paragraphs. Single line breaks are treated as line breaks within a paragraph.

In addition, the editor supports a few additional types of white spaces:

• A non-breaking space can be inserted with Ctrl+K, Space.

• Thin spaces are also supported, and can be inserted with Ctrl+K, Shift+Space.

• Non-breaking thin space can be inserted with Ctrl+K, Ctrl+Space.

These are all insert features, and the Insert menu has more. The keyboard shortcuts for them are also
listed in Insert Shortcuts.

Non-breaking spaces are highlighted by the syntax highlighter with an alternate coloured background,
depending on the selected theme.

Tip: Non-breaking spaces are for instance the correct type of space to separate a number from its unit.
Generally, non-breaking spaces are used to prevent line wrapping algorithms from adding line breaks
where they shouldn’t.

Note: You should not manually apply text indentation in your paragraphs in the editor. These can be
added automatically in the Manuscript Build tool if you want to have them in the manuscript. Each new
paragraph should be separated from the previous content by an empty line and with no indentation.
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9.4 Text Emphasis with Markdown

A minimal set of Markdown text emphasis styles are supported for text paragraphs.

_text_
The text is rendered as emphasised text (italicised).

**text**
The text is rendered as strongly emphasised text (bold).

~~text~~
Strike through text.

In Markdown guides it is often recommended to differentiate between strong emphasis and emphasis by
using ** for strong and _ for emphasis, although Markdown generally also supports __ for strong and
* for emphasis. However, since the differentiation makes the highlighting and conversion significantly
simpler and faster, in novelWriter this is a rule, not just a recommendation.

In addition, the following rules apply:

1. The emphasis and strike through formatting tags do not allow spaces between the words and the
tag itself. That is, **text** is valid, **text ** is not.

2. More generally, the delimiters must be on the outer edge of words. That is, some **text in
bold** here is valid, some** text in bold** here is not.

3. If using both ** and _ to wrap the same text, the underscore must be the inner wrapper. This is
due to the underscore also being a valid word character, so if they are on the outside, they violate
rule 2.

4. Text emphasis does not span past line breaks. If you need to add emphasis to multiple lines or
paragraphs, you must apply it to each of them in turn.

5. Text emphasis can only be used in comments and paragraphs. Headings and meta data tags don’t
allow for formatting, and any formatting markup will be rendered as-is.

Tip: novelWriter supports standard escape syntax for the emphasis markup characters in case the editor
misunderstands your intended usage of them. That is, \*, \_ and \~ will generate a plain *, _ and ~,
respectively, without interpreting them as part of the markup.

9.5 Formatting with Shortcodes

For additional formatting options, you can use shortcodes. Shortcodes is a form of in-line codes that
can be used to change the format of the text that follows and opening code, and last until that formatting
region is ended with a closing code.

These shortcodes are intended for special formatting cases, or more complex cases that cannot be solved
with simple Markdown-like formatting codes. Available shortcodes are listed below.
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Table 1: Shortcodes Formats

Syntax Description
[b]text[/b] Text is rendered as bold text.
[i]text[/i] Text is rendered as italicised text.
[s]text[/s] Text is rendered as strike through text.
[u]text[/u] Text is rendered as underlined text.
[m]text[/m] Text is rendered as highlighted text.
[sup]text[/sup] Text is rendered as superscript text.
[sub]text[/sub] Text is rendered as subscript text.

Unlike Markdown style codes, these can be used anywhere within a paragraph. Even in the middle of a
word if you need to. You can also freely combine them to form more complex formatting.

The shortcodes are available from the Format menu and in the editor toolbar, which can be activated by
clicking the left-most icon button in the editor header.

Note: Shortcodes are not processed until you generate a preview or generate a manuscript document.
So there is no highlighting of the text between the formatting markers. There is also no check that your
markers make sense. You must ensure that you have both the opening and closing formatting markers
where you want them.

New in version 2.2.

9.6 Comments and Synopsis

In addition to the above formatting features, novelWriter also allows for comments in documents. The
text of a comment is always ignored by the word counter. The text can also be filtered out when building
the manuscript or viewing the document.

The first word of a comment, followed by a colon, can be one of a set of modifiers that indicates the
comment is intended for a specific purpose. For instance, if the comment starts with Synopsis:, the
comment is treated in a special manner and will show up in the The Novel Outline View in a dedicated
column. The word synopsis is not case sensitive. If it is correctly formatted, the syntax highlighter will
indicate this by altering the colour of the word.

The different styles of comments are as follows:

% Your comment text ...
This is a comment. The text is not rendered by default (this can be overridden), seen in the docu-
ment viewer, or counted towards word counts. It is intended for you to make notes in your text for
your own sake, whatever that may be, that isn’t part of the story text. This is the general format of
a comment.

%Synopsis: Your synopsis text ...
This is a synopsis comment. It is generally treated in the same way as a regular comment, except
that it is also captured by the indexing algorithm and displayed in the The Novel Outline View. It can
also be filtered separately when building the project to for instance generate an outline document
of the whole project.
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%Short: Your short description ...
This is a short description comment. It is identical to the synopsis comment (they are interchange-
able), but is intended to be used for project notes. The text shows up in the Reference panel below
the document viewer in the last column labelled Short Description.

%Footnote.<key>: Your footnote text ...
This is a special comment assigned to a footnote marker. See Footnotes for how to use them in
your text.

Note: Only one comment can be flagged as a synopsis or short comment for each heading. If multiple
comments are flagged as synopsis or short comments, the last one will be used and the rest ignored.

9.7 Footnotes

Footnotes are added with a shortcode, paired with a matching comment for the actual footnote text. The
matching is done with a key that links the two. If you insert a footnote from the Insert menu, a unique
key is generated for you.

The insert feature will add the footnote shortcode marker at the position of your cursor in the text, and
create the associated footnote comment right after the paragraph, and move the cursor there so you can
immediately start typing the footnote text.

The footnote comment can be anywhere in the document, so if you wish to move them to, say, the bottom
of the text, you are free to do so.

Footnote keys are only required to be unique within a document, so if you copy, move or merge text,
you must make sure the keys are not duplicated. If you use the automatically generated keys from the
Insert menu, they are unique among all indexed documents. They are not guaranteed to be unique against
footnotes in the Archive or Trash folder though, but the chance of accidentally generating the same key
twice in a project is relatively small in the first place (1 in 810 000).

This is what a footnote inserted into a paragraph may look like when completed:

This is a text paragraph with a footnote[footnote:fn1] in the middle.

%Footnote.fn1: This is the text of the footnote.

New in version 2.5.

9.8 Ignored Text

If you want to completely ignore some of the text in your documents, but are not ready to delete it, you
can add %~ before the text paragraph or line. This will cause novelWriter to skip the text entirely when
generating previews or building manuscripts.

This is a better way of removing text than converting them to regular comments, as you may want to
include regular comments in your previews or draft manuscript.

You can toggle the ignored text feature on and off for a paragraph by pressing Ctrl+Shift+D on your
keyboard with your cursor somewhere in the paragraph.
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Example:

%~ This text is ignored.

This text is a regular paragraph.

9.9 Tags and References

The document editor supports a set of keywords used for setting tags, and making references between
documents based on those tags.

You must use the keyword @tag: to define a tag. The tag can be set once per section defined by a heading.
Setting it multiple times under the same heading will just override the previous setting.

@tag: value
A tag keyword followed by the tag value, like for instance the name of a character.

References can be set anywhere within a section, and are collected according to their category. References
are on the form:

@keyword: value1, value2, ..., valueN
A reference keyword followed by a value, or a comma separated list of values.

Tags and references are covered in detail in the Tags and References chapter. The keywords can be
inserted at the cursor position in the editor via the Insert menu. If you start typing an @ on a new line,
and auto-complete menu will also pop up suggesting keywords.

9.10 Paragraph Alignment and Indentation

All documents have the text by default aligned to the left or justified, depending on your setting in Pref-
erences.

You can override the default text alignment on individual paragraphs by specifying alignment tags. These
tags are double angle brackets. Either >> or <<. You put them either before or after the paragraph, and
they will “push” the text towards the edge the brackets point towards. This should be fairly intuitive.

Indentation uses a similar syntax. But here you use a single > or < to push the text away from the edge.

Examples:

Table 2: Text Alignment and Indentation

Syntax Description
>> Right aligned text The text paragraph is right-aligned.
Left aligned text << The text paragraph is left-aligned.
>> Centred text << The text paragraph is centred.
> Left indented text The text has an increased left margin.
Right indented text < The text has an increased right margin.
> Left/right indented text < The text has both margins increased.

Note: The text editor will not show the alignment and indentation live. But the viewer will show them
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when you open the document there. It will of course also be reflected in the document generated from
the manuscript build tool as long as the format supports paragraph alignment.

9.10.1 Alignment with Line Breaks

If you have line breaks in the paragraph, the markers for all the lines are combined and used for the entire
paragraph. For the following text, all lines will be centred:

>> I am the very model of a modern Major-General
I've information vegetable, animal, and mineral
I know the kings of England, and I quote the fights historical
From Marathon to Waterloo, in order categorical <<

9.10.2 Alignment with First Line Indent

If you have first line indent enabled in your Manuscript build settings, you probably want to disable it
for text in verses. Adding any alignment tags will cause the first line indent to be switched off for that
paragraph.

The following text will always be aligned against the left margin:

I am the very model of a modern Major-General <<
I've information vegetable, animal, and mineral
I know the kings of England, and I quote the fights historical
From Marathon to Waterloo, in order categorical

9.11 Vertical Space and Page Breaks

You can apply page breaks to partition, chapter and scene headings for novel documents from the
Manuscript Build tool. If you need to add a page break or additional vertical spacing in other places,
there are special codes available for this purpose.

Adding more than one line break between paragraphs will not increase the space between those para-
graphs when building the project. To add additional space between paragraphs, add the text [vspace]
on a line of its own, and the build tool will insert a blank paragraph in its place.

If you need multiple blank paragraphs just add a colon and a number to the above code. For instance,
writing [vspace:3] will insert three blank paragraphs.

If you need to add a page break somewhere, put the text [new page] on a line by itself before the text
you wish to start on a new page.

Note: The page break code is applied to the text that follows it. It adds a “page break before” mark to
the text when exporting to HTML or Open Document. This means that a [new page] which has no text
following it, it will not result in a page break.

Example:
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This is a text paragraph.

[vspace:2]

This is another text paragraph, but there will be two empty paragraphs
between them.

[new page]

This text will start on a new page if the build format has pages.

9.12 Inserting Word Counts in the Text

The cover page of a manuscript normally has the word count stated on it. Any statistics value collected
by novelWriter can be inserted into any document. You can generate the code for this from the Insert
menu under Word/Character Count.

The value inserted is the actual count for your entire manuscript, so it is not populated until you run the
Manuscript Build tool. Until then they will show up as “0” in the viewer panel.
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CHAPTER

TEN

KEYBOARD SHORTCUTS

Most features in novelWriter are available as keyboard shortcuts. This is a reference list of those shortcuts.
Most of them are also listed in the application’s user interface.

Note: On MacOS, replace Ctrl with Cmd.

10.1 Main Window Shortcuts

Shortcut Description
F1 Open the online user manual
F5 Open the Build Manuscript tool
F6 Open the Writing Statistics tool
F8 Toggle Focus Mode
F9 Re-build the project’s index
F11 Toggle full screen mode
Ctrl+, Open the Preferences dialog
Ctrl+E Switch or toggle focus for the editor or viewer
Ctrl+T Switch or toggle focus for the project tree or novel view
Ctrl+Q Exit novelWriter
Ctrl+Shift+, Open the Project Settings dialog
Ctrl+Shift+O Open the Welcome dialog to open or create a project
Ctrl+Shift+S Save the current project
Ctrl+Shift+T Switch focus to the outline view
Ctrl+Shift+W Close the current project
Shift+F1 Open the local user manual (PDF) if it is available
Shift+F6 Open the Project Details dialog
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10.2 Project Tree Shortcuts

Shortcut Description
F2 Edit the label of the selected item
Return Open the selected document in the editor
Alt+Up Jump or go to the previous item at same level in the tree
Alt+Down Jump or go to the next item at same level in the tree
Alt+Left Jump to the parent item in the tree
Alt+Right Jump to the first child item in the project tree
Ctrl+. Open the context menu on the selected item
Ctrl+L Open the Quick Links menu
Ctrl+N Open the Create New Item menu
Ctrl+O Open the selected document in the editor
Ctrl+R Open the selected document in the viewer
Ctrl+Up Move selected item one step up in the tree
Ctrl+Down Move selected item one step down in the tree
Ctrl+Shift+Del Move the selected item to Trash

10.3 Document Editor Shortcuts

10.3.1 Text Search Shortcuts

Shortcut Description
F3 Find the next occurrence of the search word
Ctrl+F Open search and look for the selected word
Ctrl+G Find the next occurrence of the search word
Ctrl+H Open replace and look for the selected word (Mac Cmd+=)
Ctrl+Shift+1 Replace selected occurrence, and move to the next
Ctrl+Shift+G Find the previous occurrence of the search word
Ctrl+Shift+F Open project search and look for the selected word
Shift+F3 Find the previous occurrence of the search word
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10.3.2 Text Formatting Shortcuts

Shortcut Description
Ctrl+' Wrap selected text, or word under cursor, in single quotes
Ctrl+" Wrap selected text, or word under cursor, in double quotes
Ctrl+/ Toggle comment format for block or selected text
Ctrl+0 Remove format for block or selected text
Ctrl+1 Change block format to heading level 1
Ctrl+2 Change block format to heading level 2
Ctrl+3 Change block format to heading level 3
Ctrl+4 Change block format to heading level 4
Ctrl+5 Change block alignment to left-aligned
Ctrl+6 Change block alignment to centred
Ctrl+7 Change block alignment to right-aligned
Ctrl+8 Add a left margin to the block
Ctrl+9 Add a right margin to the block
Ctrl+B Format selected text, or word under cursor, with bold
Ctrl+D Format selected text, or word under cursor, with strike through
Ctrl+I Format selected text, or word under cursor, with italic
Ctrl+Shift+/ Remove format for block or selected text
Ctrl+Shift+D Toggle ignored text format for block or selected text

10.3.3 Other Editor Shortcuts

Shortcut Description
F7 Re-run the spell checker on the document
Ctrl+. Open the context menu at the current cursor location
Ctrl+A Select all text in the document
Ctrl+C Copy selected text to clipboard
Ctrl+K Activate the insert commands (see list in Insert Shortcuts)
Ctrl+R Open or reload the current document in the viewer
Ctrl+S Save the current document
Ctrl+V Paste text from clipboard to cursor position
Ctrl+W Close the current document
Ctrl+X Cut selected text to clipboard
Ctrl+Y Redo latest undo
Ctrl+Z Undo latest changes
Ctrl+Backspace Delete the word before the cursor
Ctrl+Del Delete the word after the cursor
Ctrl+F7 Toggle spell checking
Ctrl+Return Open the tag or reference under the cursor in the viewer
Ctrl+Shift+A Select all text in the current paragraph
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10.3.4 Insert Shortcuts

A set of insert features are also available through shortcuts, but they require a double combination of key
sequences. The insert feature is activated with Ctrl+K, followed by a key or key combination for the
inserted content.

Shortcut Description
Ctrl+K, Space Insert a non-breaking space
Ctrl+K, _ Insert a long dash (em dash)
Ctrl+K, . Insert an ellipsis
Ctrl+K, ' Insert a modifier apostrophe
Ctrl+K, * Insert a list bullet
Ctrl+K, % Insert a per mille symbol
Ctrl+K, ~ Insert a figure dash (same width as a number)
Ctrl+K, – Insert a short dash (en dash)
Ctrl+K, 1 Insert a left single quote
Ctrl+K, 2 Insert a right single quote
Ctrl+K, 3 Insert a left double quote
Ctrl+K, 4 Insert a right double quote
Ctrl+K, C Insert a @char keyword
Ctrl+K, E Insert an @entity keyword
Ctrl+K, F Insert a @focus keyword
Ctrl+K, G Insert a @tag keyword
Ctrl+K, H Insert a short description comment
Ctrl+K, L Insert a @location keyword
Ctrl+K, M Insert a @mention keyword
Ctrl+K, O Insert an @object keyword
Ctrl+K, P Insert a @plot keyword
Ctrl+K, S Insert a synopsis comment
Ctrl+K, T Insert a @time keyword
Ctrl+K, V Insert a @pov keyword
Ctrl+K, X Insert a @custom keyword
Ctrl+K, Ctrl+Space Insert a thin non-breaking space
Ctrl+K, Ctrl+_ Insert a horizontal bar (quotation dash)
Ctrl+K, Ctrl+' Insert a prime
Ctrl+K, Ctrl+" Insert a double prime
Ctrl+K, Ctrl+* Insert a flower mark (alternative bullet)
Ctrl+K, Ctrl+– Insert a hyphen bullet (alternative bullet)
Ctrl+K, Ctrl+D Insert a division sign
Ctrl+K, Ctrl+O Insert a degree symbol
Ctrl+K, Ctrl+X Insert a times sign
Ctrl+K, Shift+Space Insert a thin space
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10.4 Document Viewer Shortcuts

Shortcut Description
Alt+Left Move backward in the view history
Alt+Right Move forward in the view history
Ctrl+C Copy selected text to clipboard
Ctrl+Shift+A Select all text in the current paragraph
Ctrl+Shift+R Close the document viewer
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CHAPTER

ELEVEN

TYPOGRAPHICAL NOTES

novelWriter has some support for typographical symbols that are not usually easily available in many text
editors. This includes for instance the proper unicode quotation marks, dashes, ellipsis, thin spaces, etc.
All these symbols are available from the Insert menu, and via keyboard shortcuts. See Insert Shortcuts.

This chapter provides some additional information on how novelWriter handles these symbols.

11.1 Special Notes on Symbols

This section contains additional notes on the available special symbols.

11.1.1 Dashes and Ellipsis

With the auto-replace feature enabled (see Auto-Replace as You Type), multiple hyphens are converted
automatically to short and long dashes, and three dots to ellipsis. The last auto-replace can always be
reverted with the undo command Ctrl+Z, reverting the text to what you typed before the automatic
replacement occurred.

In addition, “Figure Dash” is available. The Figure Dash is a dash that has the same width as the numbers
of the same font, for most fonts. It helps to align numbers nicely in columns when you need to use a dash
in them.

11.1.2 Single and Double Quotes

All the different quotation marks listed on the Quotation Mark Wikipedia page are available, and can be
selected as auto-replaced symbols for straight single and double quote key strokes. The settings can be
found in Preferences.

Ordinarily, text wrapped in quotes are highlighted by the editor. This is meant as a convenience for
highlighting dialogue between characters. This feature can be disabled in Preferences if this feature isn’t
wanted.

The editor distinguishes between text wrapped in regular straight double quotes and the user-selected
double quote symbols. This is to help the writer recognise which parts of the text are not using the
chosen quote symbols. Two convenience functions in the Format menu can be used to re-format a
selected section of text with the correct quote symbols.
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11.1.3 Single and Double Prime

Both single and double prime symbols are available in the Insert menu. These symbols are the correct
symbols to use for unit symbols for feet, inches, minutes, and seconds. The usage of these is described
in more detail on the Wikipedia Prime page. They look very similar to single and double straight quotes,
and may be rendered similarly by the font, but they have different codes. Using these correctly will also
prevent the auto-replace and dialogue highlighting features misunderstanding their meaning in the text.

11.1.4 Modifier Letter Apostrophe

The auto-replace feature will consider any right-facing single straight quote as a quote symbol, even if
it is intended as an apostrophe. This also includes the syntax highlighter, which may assume the first
following apostrophe is the closing symbol of a single quoted region of text.

To get around this, an alternative apostrophe is available. It is a special Unicode character that is not
categorised as punctuation, but as a modifier. It is usually rendered the same way as the right single
quotation marks, depending on the font. There is a Wikipedia article for the Modifier letter apostrophe
with more details.

Note: On export with the Build Manuscript tool, these apostrophes will be replaced automatically with
the corresponding right hand single quote symbol as is generally recommended. Therefore it doesn’t
really matter if you only use them to correct syntax highlighting.

11.1.5 Special Space Symbols

A few variations of the regular space character is supported. The correct typographical way to separate
a number from its unit is with a thin space. It is usually 2/3 the width of a regular space. For numbers
and units, this should in addition be a non-breaking space, that is, the text wrapping should not add a line
break on this particular space.

A regular space can also be made into a non-breaking space if needed.

All non-breaking spaces are highlighted with a differently coloured background to make it easier to spot
them in the text. The colour will depend on the selected colour theme.

The thin and non-breaking spaces are converted to their corresponding HTML codes on export to HTML
format.
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CHAPTER

TWELVE

MANAGING PROJECTS

Your text in novelWriter is organised into projects. Each project is meant to contain one novel and
associated notes. If you have multiple novels in a series, with the same characters and shared notes, it is
also possible to keep all of them in the same project.

12.1 Creating Project

New projects can be created from the Project menu by selecting Create or Open Project. This will
open the Welcome dialog, where you can select the New button that will assist you in creating a new
project. This dialog is also displayed when you start novelWriter.

A novelWriter project requires a dedicated folder for storing its files on the local file system. If you’re
interested in the details, you can have a look at the chapter How Data is Stored.

A list of recently opened projects is maintained, and displayed in the Welcome dialog. A project can be
removed from this list by selecting it and pressing the Del key or by right-clicking it and selecting the
Remove Project option.

Fig. 1: The project list (left) and new project form (right) of the Welcome dialog.

Project-specific settings are available in Project Settings in the Project menu. See further details below
in the Project Settings section.

Details about the project’s novel text, including word counts, and a table of contents with word and page
counts, is available through the Novel Details dialog. Statistics about the project is also available in the
Manuscript Build tool.
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12.1.1 Template Projects

From the Welcome dialog you can also create a new from another existing project. If you have a specific
structure you want to use for all your new projects, you can create a dedicated project to be used as a
template, and select to copy an existing project from the :guilabel:”Prefill Project” option from the New
Project form.

12.2 Project Structure

Projects are structured into a set of top level folders called “Root Folders”. They are visible in the project
tree at the left side of the main window.

The novel documents go into a root folder of type Novel. Project notes go into the other root folders.
These other root folder types are intended for your notes on the various elements of your story. Using
them is of course entirely optional.

A new project may not have all of the root folders present, but you can add the ones you want from the
project tree tool bar.

Each root folder has one or more reference keyword associated with it that is used to reference them from
other documents and notes. The intended usage of each type of root folder is listed below. However,
aside from the Novel folder, no restrictions are applied by the application on what you put in them. You
can use them however you want.

The root folder system is closely connected to how the Tags and References system works. For more
details, see the Tags and References chapter.

12.2.1 Root Folder Types

Novel
This is the root folder type for text that goes into the final novel or novels. This class of documents
have other rules and features than the project notes. See Novel Structure for more details.

Plot
This is the root folder type where main plots can be outlined. It is optional, but adding at least brief
notes can be useful in order to tag plot elements for the Outline View. Tags in this folder can be
references using the @plot keyword.

Characters
Character notes go in this root folder type. These are especially important if you want to use the
Outline View to see which character appears where, which part of the story is told from a specific
character’s point-of-view, or focusing on a particular character’s storyline.

The character names can also be inserted into for instance chapter titles when you create your
manuscript. Tags in this type of folder can be referenced using the @pov keyword for point-of-view
characters, @focus for a focus character, or the @char keyword for any other character present.

Locations
The locations folder type is for various scene locations that you want to track. Tags in this folder
can be references using the @location keyword.

Timeline
If the story has multiple plot timelines or jumps in time within the same plot, this folder type can
be used to track this. Tags in this type of folder can be references using the @time keyword.
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Objects
Important objects in the story, for instance physical objects that change hands often, can be tracked
here. Tags in this type of folder can be references using the @object keyword.

Entities
Does your plot have many powerful organisations or companies? Or other entities that are part
of the plot? They can be organised here. Tags in this type of folder can be references using the
@entity keyword.

Custom
The custom root folder type can be used for tracking anything else not covered by the above options.
Tags in this folder type can be references using the @custom keyword.

The root folders are closely tied to the tags and reference system. Each folder type corresponds to cate-
gories of tags that can be used to reference them. For more information about the tags listed, see How to
Use References.

There is also a @mention keyword that can be used to reference any tag. See How to Use References for
more details.

Note: You can rename root folders to whatever you want. However, this doesn’t change the reference
keyword or what they do.

12.2.2 Deleted Documents

Deleted documents are moved into a special Trash root folder. Documents in the trash folder can then
be deleted permanently, either individually, or by emptying the trash from the menu. Documents in the
trash folder are removed from the project index and cannot be referenced.

A document or a folder can be moved to trash from the Project menu, or by pressing Ctrl+Shift+Del.
Root folders can only be removed when they are empty.

12.2.3 Archived Documents

If you don’t want to delete a document, or put it in the Trash folder where it may be deleted accidentally,
but still want it out of your main project tree, you can create an Archive root folder instead and move it
there. It has the same effect as moving it to Trash, but it is safe from deletion.

You can drag any document to this folder and preserve its settings. The document will always be excluded
from the Build Manuscript tool. It is also removed from the project index, so the tags and references
defined in it will not show up anywhere else.
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12.2.4 Using Folders in the Project Tree

Regular folders, those that are not root folders, have no structural significance to the project. When
novelWriter is processing the documents in a project, like for instance when you create a manuscript
from it, these folders are ignored. Only the order of the documents themselves matter.

The folders are there purely as a way for you to organise the documents in meaningful sections and to be
able to collapse and hide them in the project tree when you’re not working on those documents.

In addition to using folders. it is also possible to add child documents to other documents. This is
particularly useful when you create chapters and scenes. If you add separate scene documents, you
should also add separate chapter documents, even if they only contain a chapter heading. You can then
add scene documents as child items to the chapters.

12.2.5 Recovered Documents

If novelWriter crashes or otherwise exits without saving the project state, or if you’re using a file syn-
chronisation tool that runs out of sync, there may be files in the project storage folder that aren’t tracked
in the core project file. These files, when discovered, are recovered and added back into the project when
a project is opened.

The discovered files are scanned for metadata that give clues as to where the document may previously
have been located in the project. The project loading routine will try to put them back as close as possible
to this location, if it still exists. Generally, it will be appended to the end of the folder where it previously
was located. If that folder doesn’t exist, it will try to add it to the correct root folder type. If it cannot
figure out which root folder is correct, the document will be added to the Novel root folder. Finally, if a
Novel does not exist, one will be created.

If the title of the document can be recovered, the word “Recovered:” will be added as a prefix to indicate
that it may need further attention. If the title cannot be determined, the document will be named after its
internal key, which is a string of characters and numbers.

12.2.6 Project Lockfile

To prevent data loss caused by file conflicts when novelWriter projects are synchronised via file synchro-
nisation tools, a project lockfile is written to the project storage folder when a project is open. If you try
to open a project which already has such a file present, you will be presented with a warning, and some
information about where else novelWriter thinks the project is also open. You will be given the option
to ignore this warning, and continue opening the project at your own risk.

Note: If, for some reason, novelWriter or your computer crashes, the lock file may remain even if there
are no other instances keeping the project open. In such a case it is safe to ignore the lock file warning
when re-opening the project.

Warning: If you choose to ignore the warning and continue opening the project, and multiple
instances of the project are in fact open, you are likely to cause inconsistencies and create diverging
project files, potentially resulting in loss of data and orphaned files. You are not likely to lose any
actual text unless both instances have the same document open in the editor, and novelWriter will try
to resolve project inconsistencies the next time you open the project.
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12.3 Project Documents

New documents can be created from the toolbar in the project tree, or by pressing Ctrl+N. This will open
the create new item menu and let you choose between a number of pre-defined documents and folders.
You will be prompted for a label for the new item.

You can always rename an item by selecting Rename Item from the Project menu, or by pressing F2
when a document or folder is selected.

Other settings for project documents and folders are available from the context menu that you can activate
by right-clicking on an it in the tree. The Transform submenu includes options for converting, splitting,
or merging documents. See Splitting and Merging Documents for more details on the latter two.

12.3.1 Document Templates

If you wish to create template documents to be used when creating new project documents, like for
instance a character note template, you can add a Templates root folder to your project. Any document
added to this root folder will show up in the Add Item menu in the project tree toolbar. When selected,
a new document is created with its content copied from the chosen template.

New in version 2.3.

12.3.2 Word Counts

A character, word and paragraph count is maintained for each document, as well as for each section of a
document following a heading. The word count and change of words in the current session is displayed
in the footer of any document open in the editor, and all stats are shown in the details panel below the
project tree for any document selected in the project or novel trees.

The word counts are not updated in real time, but run in the background every few seconds for as long as
the document is being actively edited.

A total project word count is displayed in the status bar. The total count depends on the sum of the values
in the project tree, which again depend on an up to date project index. If the counts seem wrong, a full
project word recount can be initiated by rebuilding the project’s index. Either from the Tools menu, or
by pressing F9.

The rules for how the counts are made is covered in more detail in Word and Text Counts.

12.4 Project Settings

The Project Settings can be accessed from the Project menu, or by pressing Ctrl+Shift+,. This will
open a dialog box, with a set of tabs.
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12.4.1 Settings Tab

The Settings tab holds the project name, author, and language settings.

The Project Name can be edited here. It is used for the main window title and for generating backup
files. So keep in mind that if you do change this setting, the backup file names will change too.

You can also change the Authors and Project Language setting. These are only used when building the
manuscript, for some formats. The language setting is also used when inserting text into documents in
the viewer, like for instance labels for keywords and special comments.

If your project is in a different language than your main spell checking language is set to, you can override
the default setting here. The project language can also be changed from the Tools menu.

You can also override the automatic backup setting for the project if you wish.

12.4.2 Status and Importance Tabs

Each document or folder of type Novel can be given a “Status” label accompanied by a coloured icon with
an optional shape selected from a list of pre-defined shapes. Each document or folder of the remaining
types can be given an “Importance” label with the same customisation options.

These labels are there purely for your convenience, and you are not required to use them for any other
features to work. No other part of novelWriter accesses this information. The intention is to use these to
indicate at what stage of completion each novel document is, or how important the content of a note is to
the story. You don’t have to use them this way, that’s just what they were intended for, but you can make
them whatever you want.

Both status and importance labels can be exported and imported so you can share them between projects,
or define a standard set for all your writing projects. When you import labels to a project, they are always
added as new labels.

See also Document Importance and Status.

Note: The status or importance level currently in use by one or more documents cannot be deleted, but
they can be edited.

12.4.3 Auto-Replace Tab

A set of automatically replaced keywords can be added in this tab. The keywords in the left column will
be replaced by the text in the right column when documents are opened in the viewer. They will also be
applied to manuscript builds.

The auto-replace feature will replace text in angle brackets that is in this list. The syntax highlighter will
add an alternate colour to text matching the syntax, but it doesn’t check if the text is in this list.

Note: A keyword cannot contain spaces. The angle brackets are added by default, and when used in the
text are a part of the keyword to be replaced. This is to ensure that parts of the text aren’t unintentionally
replaced by the content of the list.
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12.5 Backup

An automatic backup system is built into novelWriter. In order to use it, a backup path to where the
backup files are to be stored must be provided in Preferences. The path defaults to a folder named
“Backups” in your home directory.

Backups can be run automatically when a project is closed, which also implies it is run when the appli-
cation itself is closed. Backups are date stamped zip files of the project files in the project folder (files
not strictly a part of the project are ignored). The zip archives are stored in a subfolder of the backup
path. The subfolder will have the same name as the Project Name as defined in Project Settings.

The backup feature, when configured, can also be run manually from the Tools menu. It is also possible
to disable automated backups for a given project in Project Settings.

Note: For the backup to be able to run, the Project Name must be set in Project Settings. This value is
used to generate the name and path of the backups. Without it, the backup will not run at all, but it will
produce a warning message.

12.6 Writing Statistics

When you work on a project, a log file records when you opened it, when you closed it, and the total
word counts of your novel documents and notes at the end of the session, provided that the session lasted
either more than 5 minutes, or that the total word count changed. For more details about the log file, see
How Data is Stored.

A tool to view the content of the log file is available in the Tools menu under Writing Statistics. You
can also launch it by pressing F6, or find it on the sidebar.

The tool will show a list of all your sessions, and a set of filters to apply to the data. You can also export
the filtered data to a JSON file or to a CSV file that can be opened by a spreadsheet application like for
instance Libre Office Calc or Excel.

New in version 1.2: As of version 1.2, the log file also stores how much of the session time was spent
idle. The definition of idle here is that the novelWriter main window loses focus, or the user hasn’t made
any changes to the currently open document in five minutes. The number of minutes can be altered in
Preferences.

12.6.1 Session Timer

A session timer is by default visible in the status bar. The icon will show you a clock icon when you are
active, and a pause icon when you are considered “idle” per the criteria mentioned above.

If you do not wish to see the timer, you can click on it once to hide it. The icon will still be visible. Click
the icon once more to display the timer again.

New in version 2.6: As of version 2.6, clicking the timer text or icon in the status bar will toggle its
visibility.
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CHAPTER

THIRTEEN

NOVEL STRUCTURE

This chapter covers the structure of a novel project.

There are two different types of documents in a project, Novel Documents and Project Notes. Active
novel documents can only live in a Novel type root folder. You can also move them to Archive and Trash
of course, where they become inactive.

The project tree can distinguish between the different heading levels of the novel documents using
coloured icons, and optionally add emphasis on the label. Emphasis can be enabled in Preferences.

13.1 Importance of Headings

Subfolders under root folders have no impact on the structure of the novel itself. The structure is instead
dictated by the heading level of the headings within the documents.

Four levels of headings are supported, signified by the number of hashes (#) preceding the title. See also
the Formatting Your Text section for more details about the markup syntax.

Note: The heading levels are not only important when generating the manuscript, they are also used by
the indexer when building the outline tree in the Outline View as well as in the Novel Tree. Each heading
also starts a new region where new Tags and References can be defined. See Tags and References for
more details.

The syntax for the four basic heading types, and the three special types, is listed in section Headings.
The meaning of the four levels for the structure of your novel is as follows:

Heading Level 1: Partition
This heading level signifies that the text refers to a top level heading. This is useful when you want
to split the manuscript up into books, parts, or acts. These headings are not required. The novel
title itself should use the special heading level #! covered in Headings.

Heading Level 2: Chapter
This heading level signifies a chapter. Each time you want to start a new chapter, you must add
such a heading. If you choose to split your manuscript up into one document per scene, you need
a single chapter document with just the heading. You can of course also add a synopsis and ref-
erence keywords to the chapter document. If you want to open the chapter with a quote or other
introductory text that isn’t part of a scene, this is also where you’d put that text.

Heading Level 3: Scene
This heading level signifies a scene. You must provide a title text, but the title text can be replaced
with a scene separator or just skipped entirely when you build your manuscript. If you need to
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distinguish between hard and soft scene breaks, there is an alternative format for scenes you can
use for this distinction. The formatting is covered in Headings. See also Hard and Soft Scene
Breaks.

Heading Level 4: Section
This heading level can be used to split up a scene, usually called a “section” in the documentation
and the user interface. These can be useful if you want to change references mid-scene, like if you
change the point-of-view character. You are free to use sections as you wish, and you can filter
them out of the final manuscript.

Page breaks can be automatically added before titles, partition, chapter and scene headings from the
Manuscript Build tool when you build your project to a format that supports page breaks. If you want
page breaks in other places, you have to specify them manually. See Vertical Space and Page Breaks.

Tip: There are multiple options of how to process novel headings when building the manuscript. For
instance, chapter numbers can be applied automatically, and so can scene numbers if you want them in
a draft manuscript. You can also insert point-of-view character names in chapter titles. See the Building
the Manuscript page for more details.

Note: As of 2.6, the heading levels internally in novelWriter do not map directly to heading levels in
manuscript documents. In manuscript documents, chapters are considered the top level heading, and
partitions become plain text paragraphs with a larger font.

New in version 2.6.

13.1.1 Novel Title and Front Matter

It is recommended that you add a document at the very top of each Novel root folder with the novel title
in it. You should modify the level 1 heading format code with an ! in order to render it as a document
title that is excluded from any automatic Table of Content in a manuscript build document.

You can also add the author name and address above this if this is required by the manuscript format you
use, and additional space added before the title.

This is the title page novelWriter generates automatically for a new project as of version 2.6:

Jane Doe[br]
Address 1[br]
Address 2 <<

[vspace:5]

#! My Novel

>> **By Jane Doe** <<

>> Word Count: [field:textWords] <<

The title is by default centred on the page. You can add more text to the page as you wish, like for instance
the author’s name and details.
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If you want an additional page of text after the title page, starting on a fresh page, you can add [new
page] on a line by itself, and continue the text after it. This will insert a page break before the text. See
also Vertical Space and Page Breaks.

13.1.2 Unnumbered Chapter Headings

If you use the automatic numbering feature for your chapters, but you want to keep some special chapters
separate from this, you can add an ! to the level 2 heading formatting code to tell the build tool to skip
these chapters when adding numbers.

##! Unnumbered Chapter Title

Chapter Text

There is a separate formatting feature for such chapter titles in the Manuscript Build tool as well. See
the Building the Manuscript page for more details. When building a document of a format that supports
page breaks, also unnumbered chapters can have a page break added just like for normal chapters.

13.1.3 Hard and Soft Scene Breaks

If you need two different ways to style scenes in your manuscript, like if you want to insert different scene
separators for soft and hard scene breaks, there is an alternative scene format available for scene headings
with a ! added to the formatting code.

### Soft Scene Transition

A soft scene break.

###! Hard Scene Transition

A hard scene break.

There is a separate formatting feature for these titles in the Manuscript Build tool.

New in version 2.4.
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CHAPTER

FOURTEEN

TAGS AND REFERENCES

In novelWriter there are no forms or tables to fill in to define characters, locations or other elements of
your story. Instead, you create project notes which you can mark as representing these story elements by
creating a tag. Whenever you want to link a piece of your story to a note defining a story element, like a
character, you create a reference back to that tag. You can also cross-link your project notes in the same
way.

This is perhaps one of the features that makes novelWriter different from other, similar applications. It is
therefore not always obvious to new users how this is supposed to work, so this chapter hopes to explain
in more detail how to use this tags and references system.

Tip: If you find the Tags and Reference system difficult to follow just from reading this chapter, you can
create a new project in the Welcome dialog’s New project form and select “Create an example project”
from the “Pre-fill project” option. The example project contains several examples of tags and references.

14.1 Metadata in novelWriter

The structure of your novelWriter project is inferred from the headings within the documents, not the doc-
uments themselves. See Importance of Headings for more details. Therefore, metadata is also associated
with headings, and not the documents directly.

If you split your project into separate documents for each scene, this distinction may not matter. However,
there are several benefits to using documents at a larger structural scale when first starting your project.
For instance, it may make more sense to define all your scenes, and even chapters, in a single document
at first, or perhaps a document per act. You can later split these documents up using the document split
feature. See Splitting and Merging Documents for more details.

You can do the same with your notes. You can treat each heading as an independent element of your
notes that can be referenced somewhere else. That way you can collect all your minor or background
characters in a single note file, and still be able to reference them individually by separating them with
headings and assigning each a tag. Or, you can lay out your plot in a single document and have a tag for
each plot stage under separate headings.
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14.2 How to Use Tags

A “tag” in novelWriter is a word or phrase that you define as belonging to a heading. Tags are set by
using the @tag keyword.

The basic format of a tag is @tag: tagName.

An alternative format of a tag is @tag: tagName | displayName.

tagName (Required)
This is a unique identifier of your choosing. It is the value you use later for making references back
to this document, or section of the document.

displayName (Optional)
This is an optional display name used for the tag. When you build your manuscript, you can
for instance insert the point of view character name directly into chapter headings. By default,
the tagName value is used in such headings, but if you use a shortened format internally in your
project, you can use this to specify a more suitable format for your manuscript headings.

You can only set one tag per heading, and the tag has to be unique across all documents in the project.

After a tag has been defined, it can be referenced in novel documents, or cross-referenced in other notes.
Tags will also show up in the Outline View and in the references panel under the document viewer when
a document is open in the viewer.

The syntax highlighter will indicate to you that the keyword is correctly used and that the tag is allowed,
that is, the tag is unique. Duplicate tags should be detected as long as the index is up to date. An invalid
tag should have a green wiggly line under it, and will not receive the colour that valid tags do.

The tag is the only part of these notes that novelWriter uses. The rest of the document content is there
for you to use in whatever way you wish. Of course, the content of the documents can be added to the
manuscript, or an outline document. If you want to compile a single document of all your notes, you can
do this from the Manuscript Build tool.

New in version 2.2: Tags are no longer case sensitive. The tags are by default displayed with the capital-
isation you use when defining the tag, but you don’t have to use the same capitalisation when referencing
it later.

New in version 2.3: Tags can have an optional display name for manuscript builds.

New in version 2.6: You can now add tags also to Novel Documents. These can be used for cross-
referencing between chapters and scenes, and also from notes if desired.

Example of a heading with a tag for a character of the story:

# Character: Jane Doe

@tag: Jane | Jane Doe

Some information about the character Jane Doe.

When this is done in a document in a Root Folder of type “Characters”, the tag is automatically treated as
an available character in your project with the value “Jane”, and you will be able to reference it in any of
your other documents using the reference keywords for characters. It will also show up in the Character
tab in the Reference panel below the document viewer, and in the reference auto-completer menu in the
editor when you fill in references. See Viewing a Document and The References Auto-Completer.
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It is the root folder type that defines what category of story elements the tag is indexed under. See the
Project Structure section for an overview of available root folder types. They are also covered in the next
section.

14.3 How to Use References

Each heading of any level in your project can contain references to tags set in project notes. The references
are gathered by the indexer and used to generate the Outline View, among other things.

References are set as a keyword and a list of corresponding tags. The valid keywords are listed below. The
format of a reference line is @keyword: value1, [value2] ... [valueN]. All reference keywords
allow multiple values.

@pov
The point-of-view character for the current section. The target must be a note tag in a Character
type root folder.

@focus
The character that has the focus for the current section. This can be used in cases where the focus
is not a point-of-view character. The target must be a note tag in a Character type root folder.

@char
Other characters in the current section. The target must be a note tag in a Character type root
folder. This should not include the point-of-view or focus character if those references are used.

@plot
The plot or subplot advanced in the current section. The target must be a note tag in a Plot type
root folder.

@time
The timelines touched by the current section. The target must be a note tag in a Timeline type root
folder.

@location
The location the current section takes place in. The target must be a note tag in a Locations type
root folder.

@object
Objects present in the current section. The target must be a note tag in a Object type root folder.

@entity
Entities present in the current section. The target must be a note tag in an Entities type root folder.

@custom
Custom references in the current section. The target must be a note tag in a Custom type root
folder. The custom folder are for any other category of notes you may want to use.

@mention
Anything mentioned, but not present in the current section. It is intended for those cases where
you reveal details about a character or place in a scene without it being otherwise a part of it. This
can be useful when checking for consistency later. Any tag in any root note folder can be listed
under mentions.

@story
This is used when referencing a Novel Document, like a scene or chapter, from somewhere else in
your project.
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The syntax highlighter will alert the user that the tags and references are used correctly, and that the tags
referenced exist.

Note: The highlighter may be mistaken if the index of defined tags is out of date. If so, press F9 to
regenerate it, or select Rebuild Index from the Tools menu. In general, the index for a document is
regenerated when it is saved, so this shouldn’t normally be necessary.

Tip: If you add a reference in the editor to a tag that doesn’t yet exist, you can right-click it and select
Create Note for Tag. This will generate a new project note automatically with the new tag defined. In
order for this to be possible, a root folder for that category of references must already exist.

One note can also reference another note in the same way novel documents do. When the note is opened
in the document viewer, the references become clickable links, making it easier to follow connections
in the plot. You can follow links in the document editor by clicking them with the mouse while holding
down the Ctrl key. Clicked links are always opened in the view panel.

Project notes don’t show up in the Outline View, so referencing between notes is only meaningful if you
want to be able to click-navigate between them, or of course if you just want to highlight that two notes
are related.

Tip: If you cross-reference between notes and export your project as an HTML document using the
Manuscript Build tool, the cross-references become clickable links in the exported HTML document as
well.

Example of a novel document with references to characters and plots:

## Chapter 1

@pov: Jane

### Scene 1

@char: John, Sam
@plot: Main

Once upon a time ...

14.3.1 The References Auto-Completer

An auto-completer context menu will show up automatically in the document editor when you type the
character @ on a new line. It will first suggest tag or reference keywords for you to add, and after the :
has been added, suggest references from the list of tags you have already defined.

You can use the auto-completer to add multiple references with a , between them, and even type new
ones. New references can be created by right-clicking on them and selecting Create Note for Tag from
the menu.

New in version 2.2.
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BUILDING THE MANUSCRIPT

You can at any time build a manuscript, an outline of your notes, or any other type of document from the
text in your project. All of this is handled by the Manuscript Build tool. You can activate it from the
sidebar, the Tools menu, or by pressing F5.

New in version 2.1: This tool is new for version 2.1. A simpler tool was used for earlier versions. The
simpler tool only allows you to define a single set of options for the build, but otherwise had much the
same functionality.

15.1 The Manuscript Build Tool

Fig. 1: The Manuscript Build tool main window.

The main window of the Manuscript Build tool contains a list of all the builds you have defined, a
selection of settings, and a few buttons to generate preview, open the print dialog, or run the build to
create a manuscript document.
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15.1.1 Outline and Word Counts

Fig. 2: The Manuscript Build tool main window with the Outline visible.

The Outline tab on the left lets you navigate the headings in the preview document. It will show up to
scene level headings for novel documents, and level 2 headings for notes.

A collapsible panel of word and character counts are also available below the preview document. These
are calculated from the text you have included in the document, and are more accurate counts than what’s
available in the project tree since they are counted after formatting.

For a detailed description on how they are counted, see Word and Text Counts.

15.2 Build Settings

Each build definition can be edited by opening it in the Manuscript Build Settings dialog, either by
double-clicking or by selecting it and pressing the edit button in the toolbar.

Tip: You can keep the Manuscript Build Settings dialog open while testing the different options, and
just hit the Apply button. You can test the result of your settings by pressing the Preview button in the
main Manuscript Build window. When you’re happy with the result, you can close the settings.
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15.2.1 Document Selection

Fig. 3: The Selections page of the Manuscript Build Settings dialog.

The Selections page of the Manuscript Build Settings dialog allows you to fine tune which documents
are included in the build. They are indicated by a green arrow icon in the last column. On the right
you have some filter options for selecting content of a specific type, and a set of switches for which root
folders to include.

You can override the result of these filters by marking one or more documents and selecting to explicitly
include or exclude them by using the buttons below the tree view. The last button can be used to reset
the override and return control to the filter settings.

In the figure, the green arrow icon and the blue pin icon indicates which documents are included, and the
red forbidden icon indicates that a document is explicitly excluded.

15.2.2 Formatting Headings

The Headings page of the Manuscript Build Settings dialog allows you to set how the headings in
your Novel Documents are formatted. By default, the title is just copied as-is, indicated by the {Title}
format. You can change this to for instance add chapter numbers and scene numbers, or insert character
names, like shown in the figure above.

Clicking the edit button next to a format will copy the formatting string into the edit box where it can be
modified, and where a syntax highlighter will help indicate which parts are automatically generated by
the build tool. The Insert button is a dropdown list of these formats, and selecting one will insert it at the
position of the cursor.

Any text you add that isn’t highlighted in colours will remain in your formatted titles. {Title} will
always be replaced by the text in the heading from your documents.
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Fig. 4: The Headings page of the Manuscript Build Settings dialog.

You can preview the result of these format strings by clicking Apply, and then clicking Preview in the
Manuscript Build tool main window.

Scene Separators

If you don’t want any titles for your scenes (or for your sections if you have them), you can leave the
formatting boxes empty. If so, an empty paragraph will be inserted between the scenes or sections instead,
resulting in a gap in the text. You can also switch on the Hide setting, which will ignore them completely.
That is, there won’t even be an extra gap inserted.

Alternatively, if you want a separator text between them, like the common * * *, you can enter the
desired separator text as the format. If the format is any piece of static text, it will always be treated as a
separator.

Hard and Soft Scenes

If you wish to distinguish between so-called soft and hard scene breaks, you can use the alternative scene
heading format in your text. You can then give these headings a different formatting in the Headings
settings.

See Headings for more info on how to format headings in your text.

78 Chapter 15. Building the Manuscript



User Guide, Release 2.6

15.2.3 Output Settings

The Content, Format and Output pages of the Manuscript Build Settings dialog control a number of
other settings for the output. Some of these only apply to specific output formats, which is indicated by
the section headings on the settings pages.

15.3 Building Manuscript Documents

Fig. 5: The Manuscript Build dialog used for writing the actual manuscript documents.

When you press the Build button on the Build Manuscript tool main window, a special file dialog opens
up. This is where you pick your desired output format and where to write the file.

On the left side of the dialog is a list of all the available file formats, and on the right, a list of the
documents which are included based on the build definition you selected. You can choose an output
path, and set a base file name as well. The file extension will be added automatically.

To generate the manuscript document, press the Build button. A small progress bar will show the build
progress, but for small projects it may pass very fast.

15.3.1 File Formats

Currently, four document formats are supported.

Open Document Format
The Build tool can produce either an .odt file, or an .fodt file. The latter is just a flat version of
the document format as a single XML file. Most rich text editors support the former, and only a
few the latter.

Microsoft Word Document Format
The Microsoft Word Document format writes a single .docx file. It uses a fairly basic format that
should be compatible with most rich text editors.
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Portable Document Format (PDF)
The PDF is generated from a copy of the preview document, and should have the same formatting
capabilities as the preview. It’s identical to what is produced if you select the print option and print
to PDF.

novelWriter HTML
The HTML format writes a single .htm file with minimal style formatting. The HTML document
is suitable for further processing by document conversion tools like Pandoc, for importing in word
processors, or for printing from browser.

Standard/Extended Markdown
The Markdown format comes in both Standard and Extended flavour. The only difference in terms
of novelWriter functionality is the support for strike through text, which is not supported by the
Standard flavour.

novelWriter Markup
This is simply a concatenation of the project documents selected by the filters into a .txt file. The
documents are stacked together in the order they appear in the project tree, with comments, tags,
etc. included if they are selected. This is a useful format for exporting the project for later import
back into novelWriter.

New in version 2.6: Microsoft Word and PDF output options were added.

15.3.2 Additional Formats

In addition to the above document formats, the novelWriter HTML and Markup formats can also be
wrapped in a JSON file. These files will have a meta data entry and a body entry. For HTML, also the
accompanying CSS styles used by the preview are included.

The text body is saved in a two-level list. The outer list contains one entry per document, in the order they
appear in the project tree. Each document is then split up into a list as well, with one entry per paragraph
it contains.

These files are mainly intended for scripted post-processing for those who want that option. A JSON file
can be imported directly into a Python dict object or a PHP array, to mentions a few options.

15.4 Printing

The Print button allows you to print the content in the preview window. You can either print to one of
your system’s printers, or select PDF as your output format from the printer icon on the print dialog.

Note: The paper format should in all cases default to whatever your system default is. If you want to
change it, you have to select it from the Print Preview dialog.
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SIXTEEN

CUSTOMISATIONS

There are a few ways you can customise novelWriter yourself. Currently, you can add new GUI themes,
your own syntax themes, and install additional dictionaries.

16.1 Spell Check Dictionaries

novelWriter uses Enchant as the spell checking tool. Depending on your operating system, it may or may
not load all installed spell check dictionaries automatically.

16.1.1 Linux and MacOS

On Linux and MacOS, you generally only have to install hunspell, aspell or myspell dictionaries on your
system like you do for other applications. See your distro or OS documentation for how to do this. These
dictionaries should show up as available spell check languages in novelWriter.

16.1.2 Windows

For Windows, English is included with the installation. For other languages you have to download and
add dictionaries yourself.

Install Tool

A small tool to assist with this can be found under Tools > Add Dictionaries. It will import spell checking
dictionaries from Free Office or Libre Office extensions. The dictionaries are then installed in the install
location for the Enchant library and should thus work for any application that uses Enchant for spell
checking.

Manual Install

If you prefer to do this manually or want to use a different source than the ones mentioned above, You
need to get compatible dictionary files for your language. You need two files files ending with .aff and
.dic. These files must then be copied to the following location:

C:\Users\<USER>\AppData\Local\enchant\hunspell

This assumes your user profile is stored at C:\Users\<USER>. The last one or two folders may not exist,
so you may need to create them.

You can find the various dictionaries on the Free Desktop website.
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Note: The Free Desktop link points to a repository, and what may look like file links inside the dictionary
folder are actually links to web pages. If you right-click and download those, you get HTML files, not
dictionaries!

In order to download the actual dictionary files, right-click the “plain” label at the end of each line and
download that.

16.2 Syntax and GUI Themes

Adding your own GUI and syntax themes is relatively easy, although it requires that you manually edit
config files with colour values. The themes are defined by simple plain text config files with meta data
and colour settings.

In order to make your own versions, first copy one of the existing files to your local computer and modify
it as you like.

• The existing syntax themes are stored in novelwriter/assets/syntax.

• The existing GUI themes are stored in novelwriter/assets/themes.

• The existing icon themes are stored in novelwriter/assets/icons.

Remember to also change the name of your theme by modifying the name setting at the top of the file,
otherwise you may not be able to distinguish them in Preferences.

For novelWriter to be able to locate the custom theme files, you must copy them to the Application Data
location in your home or user area. There should be a folder there named syntax for syntax themes, just
themes for GUI themes, and icons for icon themes. These folders are created the first time you start
novelWriter.

Once the files are copied there, they should show up in Preferences with the label you set as name inside
the file.

New in version 2.0: The icontheme value was added to GUI themes. Make sure you set this value in
existing custom themes. Otherwise, novelWriter will try to guess your icon theme, and may not pick the
most suitable one.

16.2.1 Custom GUI and Icons Theme

A GUI theme .conf file consists of the following settings:

[Main]
name = My Custom Theme
description = A description of my custom theme
author = Jane Doe
credit = John Doe
url = https://example.com
license = CC BY-SA 4.0
licenseurl = https://creativecommons.org/licenses/by-sa/4.0/
icontheme = typicons_light

(continues on next page)
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(continued from previous page)

[Palette]
window = 100, 100, 100
windowtext = 100, 100, 100
base = 100, 100, 100
alternatebase = 100, 100, 100
text = 100, 100, 100
tooltipbase = 100, 100, 100
tooltiptext = 100, 100, 100
button = 100, 100, 100
buttontext = 100, 100, 100
brighttext = 100, 100, 100
highlight = 100, 100, 100
highlightedtext = 100, 100, 100
link = 100, 100, 100
linkvisited = 100, 100, 100

[GUI]
helptext = 0, 0, 0
fadedtext = 128, 128, 128
errortext = 255, 0, 0
statusnone = 120, 120, 120
statussaved = 2, 133, 37
statusunsaved = 200, 15, 39

In the Main section you must at least define the name and icontheme settings. The icontheme settings
should correspond to one of the internal icon themes, either typicons_light or typicons_dark, or
to an icon theme in your custom icons directory. The setting must match the icon theme’s folder name.

The Palette values correspond to the Qt enum values for QPalette::ColorRole, see the Qt documen-
tation for more details. The colour values are RGB numbers on the format r, g, b where each is an
integer from 0 to 255. Omitted values are not loaded and will use default values. If the helptext colour
is not defined, it is computed as a colour between the window and windowtext colour.

New in version 2.5: The fadedtext and errortext theme colour entries were added.

16.2.2 Custom Syntax Theme

A syntax theme .conf file consists of the following settings:

[Main]
name = My Syntax Theme
author = Jane Doe
credit = John Doe
url = https://example.com
license = CC BY-SA 4.0
licenseurl = https://creativecommons.org/licenses/by-sa/4.0/

[Syntax]
background = 255, 255, 255
text = 0, 0, 0

(continues on next page)
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(continued from previous page)

link = 0, 0, 0
headertext = 0, 0, 0
headertag = 0, 0, 0
emphasis = 0, 0, 0
dialog = 0, 0, 0
altdialog = 0, 0, 0
note = 0, 0, 0
hidden = 0, 0, 0
shortcode = 0, 0, 0
keyword = 0, 0, 0
tag = 0, 0, 0
value = 0, 0, 0
optional = 0, 0, 0
spellcheckline = 0, 0, 0
errorline = 0, 0, 0
replacetag = 0, 0, 0
modifier = 0, 0, 0
texthighlight = 255, 255, 255, 128

In the Main section, you must define at least the name setting. The Syntax colour values are RGB(A)
numbers of the format r, g, b, a where each is an integer from 0 to 255. The fourth value is the alpha
channel, which can be omitted.

Omitted syntax colours default to black, except background which defaults to white, and
texthighlight which defaults to white with half transparency.

New in version 2.2: The shortcode syntax colour entry was added.

New in version 2.3: The optional syntax colour entry was added.

New in version 2.4: The texthighlight syntax colour entry was added.

New in version 2.5: The dialog, altdialog, note and tag syntax colour entries were added.
straightquotes, doublequotes and singlequotes were removed.
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SEVENTEEN

PROJECT FORMAT CHANGES

Most of the changes to the file formats over the history of novelWriter have no impact on the user side
of things. The project files are generally updated automatically. However, some of the changes require
minor actions from the user.

The key changes in the formats are listed in this chapter, as well as the user actions required, where
applicable.

A full project file format specification is available in the online documentation.

Caution: When you update a project from one format version to the next, the project can no longer
be opened by a version of novelWriter prior to the version where the new file format was introduced.
You will get a notification about any updates to your project file format and will have the option to
decline the upgrade.

17.1 Format 1.5 Changes

This project format was introduced in novelWriter version 2.0 RC 2.

This is a modification of the 1.4 format. It makes the XML more consistent in that meta data have been
moved to their respective section nodes as attributes, and key/value settings now have a consistent format.
Logical flags are saved as yes/no instead of Python True/False, and the main heading of the document
is now saved to the item rather than in the index. The conversion is done automatically the first time a
project is loaded. No user action is required.

17.2 Format 1.4 Changes

This project format was introduced in novelWriter version 2.0 RC 1. Since this was a release candidate,
it is unlikely that your project uses it, but it may be the case if you’ve installed a pre-release.

This format changes the way project items (folders, documents and notes) are stored. It is a more compact
format that is simpler and faster to parse, and easier to extend. The conversion is done automatically the
first time a project is loaded. No user action is required.
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17.3 Format 1.3 Changes

This project format was introduced in novelWriter version 1.5.

With this format, the number of document layouts was reduced from eight to two. The conversion of
document layouts is performed automatically when the project is opened.

Due to the reduction of layouts, some features that were previously controlled by these layouts will be
lost. These features are instead now controlled by syntax codes, so to recover these features, some minor
modification must be made to select documents by the user.

The manual changes the user must make should be very few as they apply to document layouts that should
be used only a few places in any given project. These are as follows:

Title Pages

• The formatting of the level one title on the title page must be changed from # Title Text to #!
Title Text in order to retain the previous functionality. See Headings.

• Any text that was previously centred on the page must be manually centred using the text alignment
feature. See Paragraph Alignment and Indentation.

Unnumbered Chapters

• Since the specific layout for unnumbered chapters has been dropped, such chapters must all use the
##! Chapter Name formatting code instead of ## Chapter Name. This also includes chapters
marked by an asterisk: ## *Chapter Name, as this feature has also been dropped. See Headings.

Plain Pages

• The layout named “Plain Page” has also been removed. The only feature of this layout was that it
ensured that the content always started on a fresh page. In the new format, fresh pages can be set
anywhere in the text with the [NEW PAGE] code. See Vertical Space and Page Breaks.

17.4 Format 1.2 Changes

This project format was introduced in novelWriter version 0.10.

With this format, the way auto-replace entries were stored in the main project XML file changed.

17.5 Format 1.1 Changes

This project format was introduced in novelWriter version 0.7.

With this format, the content folder was introduced in the project storage. Previously, all novelWriter
documents were saved in a series of folders numbered from data_0 to data_f.

It also reduces the number of meta data and cache files. These files are automatically deleted if an old
project is opened. This was also when the Table of Contents file was introduced.
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17.6 Format 1.0 Changes

This is the original file format and project structure. It was in use up to version 0.6.3.
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EIGHTEEN

WORD AND TEXT COUNTS

This is an overview of how words and other counts of your text are performed. The counting rules should
be relatively standard, and are compared to Libre Office Writer rules.

The counts provided in the app on the raw text is meant to be approximate. For more accurate counts, you
need to build your manuscript in the Manuscript Tool and check the counts on the generated preview.

18.1 Text Word Counts and Stats

These are the rules for the main counts available for for each document in a project.

For all counts, the following rules apply.

1. Short (–) and long (—) dashes are considered word separators.

2. Any line starting with % or @ is ignored.

3. Trailing white spaces are ignored, including line breaks.

4. Leading > and trailing < are ignored with any spaces next to them.

5. Valid shortcodes and other commands wrapped in brackets [] are ignored.

6. In-line Markdown syntax in text paragraphs is treated as part of the text.

After the above preparation of the text, the following counts are available.

Character Count
The character count is the sum of characters per line, including leading and in-text white space
characters, but excluding trailing white space characters. Shortcodes in the text are not included,
but Markdown codes are. Only headings and text are counted.

Word Count
The words count is the sum of blocks of continuous character per line separated by any number of
white space characters or dashes. Only headings and text are counted.

Paragraph Count
The paragraph count is the number of text blocks separated by one or more empty line. A line
consisting only of white spaces is considered empty.
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18.2 Manuscript Counts

These are the rules for the counts available for a manuscript in the Manuscript Tool. The rules have
been tuned to agree with LibreOffice Writer, but will vary slightly depending on the content of your text.
LibreOffice Writer also counts the text in the page header, which the Manuscript Tool does not.

The content of each line is counted after all formatting has been processed, so the result will be more
accurate than the counts for text documents elsewhere in the app. The following rules apply:

1. Short (–) and long (—) dashes are considered word separators.

2. Leading and trailing white spaces are generally included, but paragraph breaks are not.

3. Hard line breaks within paragraph are considered white space characters.

4. All formatting codes are ignored, including shortcodes, commands and Markdown.

5. Scene and section separators are counted.

6. Comments and meta data lines are counted after they are formatted.

7. Headers are counted after they are formatted with custom formats.

The following counts are available:

Headings
The number of headings in the manuscript.

Paragraphs
The number of body text paragraphs in the manuscript.

Words
The number of words in the manuscript, including any comments and meta data text.

Words in Text
The number of words in body text paragraphs, excluding all other text.

Words in Headings
The number of words in headings, including inserted formatting like chapter numbers, etc.

Characters
The number of characters in all lines, including any comments and meta data text. Paragraph
breaks are not counted, but in-paragraph hard line breaks are.

Character in Text
The number of characters in body text paragraphs. Paragraph breaks are not counted, but in-
paragraph hard line breaks are.

Characters in Headings
The number of characters in headings.

Character in Text, No Spaces
The number of characters in body text paragraphs considered part of a word or punctuation. That
is, white space characters are not counted.

Character in Headings, No Spaces
The number of characters in headings considered part of a word or punctuation. That is, white
space characters are not counted.
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NINETEEN

FILE LOCATIONS

novelWriter will create a few files on your system outside of the application folder itself. These file
locations are described in this chapter.

19.1 Configuration

The general configuration of novelWriter, including everything that is in Preferences, is saved in one
central configuration file. The location of this file depends on your operating system. The system paths
are provided by the Qt QStandardPaths class and its ConfigLocation value.

The standard paths are:

• Linux: ~/.config/novelwriter/novelwriter.conf

• MacOS: ~/Library/Preferences/novelwriter/novelwriter.conf

• Windows: C:\Users\<USER>\AppData\Local\novelwriter\novelwriter.conf

Here, ~ corresponds to the user’s home directory on Linux and MacOS, and <USER> is the user’s user-
name on Windows.

Note: These are the standard operating system defined locations. If your system has been set up in a
different way, these locations may also be different.

19.2 Application Data

novelWriter also stores a bit of data that is generated by the user’s actions. This includes the list of recent
projects form the Welcome dialog. Custom themes should also be saved here. The system paths are
provided by the Qt QStandardPaths class and its AppDataLocation value.

The standard paths are:

• Linux: ~/.local/share/novelwriter/

• MacOS: ~/Library/Application Support/novelwriter/

• Windows: C:\Users\<USER>\AppData\Roaming\novelwriter\

Here, ~ corresponds to the user’s home directory on Linux and MacOS, and <USER> is the user’s user-
name on Windows.
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Note: These are the standard operating system defined locations. If your system has been set up in a
different way, these locations may also be different.

The Application Data location also holds several folders:

cache
This folder is used to save the preview data for the Manuscript Build tool.

icons, syntax and themes
These folders are empty by default, but this is where the user can store custom theme files. See
Customisations for more details.
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TWENTY

HOW DATA IS STORED

This chapter contains details of how novelWriter stores and handles the project data.

20.1 Project Structure

All novelWriter files are written with utf-8 encoding. Since Python automatically converts Unix line
endings to Windows line endings on Windows systems, novelWriter does not make any adaptations to
the formatting on Windows systems. This is handled entirely by the Python standard library. Python also
handles this when working on the same files on both Windows and Unix-based operating systems.

20.1.1 Main Project File

The project itself requires a dedicated folder for storing its files, where novelWriter will create its own
“file system” where the project’s folder and file hierarchy is described in a project XML file. This is the
main project file in the project’s root folder with the name nwProject.nwx. This file also contains all
the meta data required for the project (except the index data), and a number of related project settings.

If this file is lost or corrupted, the structure of the project is lost, although not the text itself. It is important
to keep this file backed up, either through the built-in backup tool, or your own backup solution.

The project XML file is indent-formatted, and is suitable for diff tools and version control since most of
the file will stay static, although a timestamp is set in the meta section on line 2, and various meta data
entries incremented, on each save.

A full project file format specification is available in the online documentation.

20.2 Project Documents

All the project documents are saved in a subfolder of the main project folder named content. Each
document has a file handle based on a 52 bit random number, represented as a hexadecimal string. The
documents are saved with a filename assembled from this handle and the file extension .nwd.

If you wish to find the file system location of a document in the project, you can either look it up in the
project XML file, select Show File Details from the Document menu when having the document open
in the editor, or look in the ToC.txt file in the root of the project folder. The ToC.txt file has a list of
all documents in the project, referenced by their label, and where they are saved.

The reason for this cryptic file naming is to avoid issues with file naming conventions and restrictions
on different operating systems, and also to have a file name that does not depend on what you name the
document within the project, or changes it to. This is particularly useful when using a versioning system.

93

https://docs.novelwriter.io/


User Guide, Release 2.6

Each document file contains a plain text version of the text from the editor. The file can in principle be
edited in any text editor, and is suitable for diffing and version control if so desired. Just make sure the file
remains in utf-8 encoding, otherwise unicode characters may become mangled when the file is opened
in novelWriter again.

Editing these files is generally not recommended. The reason for this is that the index will not be auto-
matically updated when doing so, which means novelWriter doesn’t know you’ve altered the file. If you
do edit a file in this manner, you should rebuild the index when you next open the project in novelWriter.

The first lines of the file may contain some meta data starting with the characters %%~. These lines are
mainly there to restore some information if the file is lost from the main project file, and the information
may be helpful if you do open the file in an external editor as it contains the document label and the
document class and layout. The lines can be deleted without any consequences to the rest of the content
of the file, and will be added back the next time the document is saved in novelWriter.

20.2.1 The File Saving Process

When saving the project file, or any of the documents, the data is first saved to a temporary file. If
successful, the old data file is then removed, and the temporary file replaces it. This ensures that the
previously saved data is only replaced when the new data has been successfully saved to the storage
medium.

20.3 Project Meta Data

The project folder contains a subfolder named meta, containing a number of files. The meta folder
contains semi-important files. That is, they can be lost with only minor impact to the project. All files in
this folder are JSON or JSON Lines files, although some other files may remain from earlier versions of
novelWriter as they haven’t all been JSON files in the past.

If you use version control software on your project, you can exclude this folder, although you may want
to track the session log file and the custom words list.

20.3.1 The Project Index

Between writing sessions, the project index is saved in a JSON file in meta/index.json. This file is
not critical. If it is lost, it can be completely rebuilt from within novelWriter from the Tools menu.

The index is maintained and updated whenever a document or note is saved in the editor. It contains all
references and tags in documents and notes, as well as the location of all headers in the project, and the
word counts within each header section.

The integrity of the index is checked when the file is loaded. It is possible to corrupt the index if the file
is manually edited and manipulated, so the check is important to avoid sudden crashes of novelWriter.
If the file contains errors, novelWriter will automatically build it anew. If the check somehow fails and
novelWriter keeps crashing, you can delete the file manually and rebuild the index. If this too fails, you
have likely encountered a bug.

94 Chapter 20. How Data is Stored



User Guide, Release 2.6

20.3.2 Build Definitions

The build definitions from the Manuscript Build tool are kept in the meta/builds.json file. If this
file is lost, all custom build definitions are lost too.

20.3.3 Cached GUI Options

A file named meta/options.json contains the latest state of various GUI buttons, switches, dialog
window sizes, column sizes, etc, from the GUI. These are the GUI settings that are specific to the project.
Global GUI settings are stored in the main config file.

The file is not critical, but if it is lost, all such GUI options will revert back to their default settings.

20.3.4 Custom Word List

A file named meta/userdict.json contains all the custom words you’ve added to the project for spell
checking purposes. The content of the file can be edited from the Tools menu. If you lose this file, all
your custom spell check words will be lost too.

20.3.5 Session Stats

The writing progress is saved in the meta/sessions.jsonl file. This file records the length and word
counts of each writing session on the given project. The file is used by the Writing Statistics tool. If
this file is lost, the history it contains is also lost, but it has otherwise no impact on the project.

Each session is recorded as a JSON object on a single line of the file. Each session record is appended
tot he file.
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CHAPTER

TWENTYONE

RUNNING FROM SOURCE

This chapter describes various ways of running novelWriter directly from the source code, and how to
build the various components like the translation files and documentation.

Note: The text below assumes the command python corresponds to a Python 3 executable. Python 2
is now deprecated, but on many systems the command python3 may be needed instead. Likewise, pip
may need to be replaced with pip3.

Most of the custom commands for building packages of novelWriter, or building assets, are contained in
the pkgutils.py script in the root of the source code. You can list the available commands by running:

python pkgutils.py help

21.1 Dependencies

novelWriter has been designed to rely on as few dependencies as possible. Only the Python wrapper
for the Qt GUI libraries is required. The package for spell checking is optional, but recommended.
Everything else is handled with standard Python libraries.

The following Python packages are needed to run all features of novelWriter:

• PyQt5 – needed for connecting with the Qt5 libraries.

• PyEnchant – needed for spell checking (optional).

PyQt/Qt must be at least 5.15.0. If you want spell checking, you must install the PyEnchant package.
The spell check library must be at least 3.0 to work with Windows. On Linux, 2.0 also works fine.

If you install from PyPi, these dependencies should be installed automatically. If you install from source,
dependencies can still be installed from PyPi with:

pip install -r requirements.txt

Note: On Linux distros, the Qt library is usually split up into multiple packages. In some cases, sec-
ondary dependencies may not be installed automatically. For novelWriter, the library files for rendering
the SVG icons may be left out and needs to be installed manually. This is the case on for instance Arch
Linux.
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21.2 Build and Install from Source

If you want to install novelWriter directly from the source available on GitHub, you must first build the
package using the Python Packaging Authority’s build tool. It can be installed with:

pip install build

On Debian-based systems the tool can also be installed with:

sudo apt install python3-build

With the tool installed, run the following command from the root of the novelWriter source code:

python -m build --wheel

This should generate a .whl file in the dist/ folder at your current location. The wheel file can then be
installed on your system. Here with example version number 2.0.7, but yours may be different:

pip install --user dist/novelWriter-2.0.7-py3-none-any.whl

21.3 Building the Translation Files

If you installed novelWriter from a package, the translation files should be pre-built and included. If
you’re running novelWriter from the source code, you will need to generate the files yourself. The files
you need will be written to the novelwriter/assets/i18n folder, and will have the .qm file extension.

You can build the .qm files with:

python pkgutils.py qtlrelease

This requires that the Qt Linguist tool is installed on your system. On Ubuntu and Debian, the needed
package is called qttools5-dev-tools.

Note: If you want to improve novelWriter with translation files for another language, or update an
existing translation, instructions for how to contribute can be found in the README.md file in the i18n
folder of the source code.

21.4 Building the Example Project

In order to be able to create new projects from example files, you need a sample.zip file in the assets
folder of the source. This file can be built from the pkgutils.py script by running:

python pkgutils.py sample
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21.5 Building the Documentation

A local copy of this documentation can be generated as HTML. This requires installing some Python
packages from PyPi:

pip install -r docs/source/requirements.txt

The documentation can then be built from the root folder in the source code by running:

make -C docs html

If successful, the documentation should be available in the docs/build/html folder and you can open
the index.html file in your browser.

You can also build a PDF manual from the documentation using the pkgutils.py script:

python pkgutils.py manual

This will build the documentation as a PDF using LaTeX. The file will then be copied into the assets
folder and made available in the Help menu in novelWriter. The Sphinx build system has a few extra
dependencies when building the PDF. Please check the Sphinx Docs for more details.
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CHAPTER

TWENTYTWO

RUNNING TESTS

The novelWriter source code is well covered by tests. The test framework used for the development is
pytest with the use of an extension for Qt.

22.1 Dependencies

The dependencies for running the tests can be installed with:

pip install -r tests/requirements.txt

This will install a couple of extra packages for coverage and test management. The minimum requirement
is pytest and pytest-qt.

22.2 Simple Test Run

To run the tests, you simply need to execute the following from the root of the source folder:

pytest

Since several of the tests involve opening up the novelWriter GUI, you may want to disable the GUI for
the duration of the test run. Moving your mouse while the tests are running may otherwise interfere with
the execution of some tests.

You can disable the renderring of the GUI by setting the flag QT_QPA_PLATFORM=offscreen:

export QT_QPA_PLATFORM=offscreen pytest

22.3 Advanced Options

Adding the flag -v to the pytest command will increase verbosity of the test execution.

You can also add coverage report generation. For instance to HTML:

export QT_QPA_PLATFORM=offscreen pytest -v --cov=novelwriter --cov-report=html

Other useful report formats are xml, and term for terminal output.

You can also run tests per subpackage of novelWriter with the -m command. The available subpackage
groups are base, core, and gui. Consider for instance:

101



User Guide, Release 2.6

export QT_QPA_PLATFORM=offscreen pytest -v --cov=novelwriter --cov-
→˓report=html -m core

This will only run the tests of the “core” package, that is, all the classes that deal with the project data
of a novelWriter project. The “gui” tests, likewise, will run the tests for the GUI components, and the
“base” tests cover the bits in-between.

You can also filter the tests with the -k switch. The following will do the same as -m core:

export QT_QPA_PLATFORM=offscreen pytest -v --cov=novelwriter --cov-
→˓report=html -k testCore

All tests are named in such a way that you can filter them by adding more bits of the test names. They
all start with the word “test”. Then comes the group: “Core”, “Base”, “Dlg”, “Tool”, or “Gui”. Finally
comes the name of the class or module, which generally corresponds to a single source code file. For
instance, running the following will run all tests for the document editor:

export QT_QPA_PLATFORM=offscreen pytest -v --cov=novelwriter --cov-
→˓report=html -k testGuiEditor

To run a single test, simply add the full test name to the -k switch.
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